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Power Analysis and Optimization Tutorial

This tutorial introduces the power analysis and optimization use model recommended for use with the
Xilinx® Vivado® Integrated Design Environment (IDE). The tutorial describes the basic steps involved in
taking a small example design from RTL to implementation, estimating power through the different
stages, and using simulation data to enhance the accuracy of the power analysis. It also describes the
steps involved in using the power optimization tools in the design.

- VIDEO: The Vivado Design Suite QuickTake Video: Power Estimation and Analysis Using Vivado
m shows how the Vivado Design Suite can help you to estimate power consumption in your design
and reviews best practices for getting the most accurate estimation.

VIDEO: The Vivado Design Suite QuickTake Video: Power Optimization Using Vivado describes the

7 factors that affect power consumption in an FPGA, shows how the Vivado Design Suite helps to
minimize power consumption in your design, and looks at some advanced control and best
practices for getting the most out of Vivado power optimization.

Software Requirements

This tutorial requires that the Vivado Design Suite software 2017.1 release or later is installed. For
installation instructions and information, see the Vivado Design Suite User Guide: Release Notes,
Installation, and Licensing (UG973).

For hardware power measurement of 7 series devices, the tutorial requires Texas Instruments Fusion
Design Power Designer software, which can be downloaded from the following location:
http://www.ti.com/tool/fusion_digital_power_designer

For hardware power measurement of UltraScale™ devices, the tutorial requires Maxim Digital Power
Tool software, which can be downloaded from the following location:
https://www.maximintegrated.com/en/design/tools/applications/evkit-software/index.mvp?id=1183
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Hardware Requirements

Supported Operating Systems to run the Vivado Design Suite, and memory recommendations when
using the Vivado tools, are described in the Vivado Design Suite User Guide: Release Notes, Installation,
and Licensing (UG973).

Hardware Requirements for 7 Series Devices

e The hardware power measurements for 7 series devices

(needed in Lab 3: Measuring Hardware Power Using the KC705 Evaluation Board), require a
Xilinx Kintex®-7 FPGA KC705 Evaluation Kit. You can find information on the Evaluation Kit at this
location:

Xilinx Kintex®-7 FPGA KC705 Evaluation Kit
e For power measurements through TI Power Regulators

(needed in Lab 3: Measuring Hardware Power Using the KC705 Evaluation Board), use the Texas
Instruments USB Interface Adapter. You can find information on the USB Interface Adaptor at
this location:

www.ti.com/lit/ml/sllu093/sllu093.pdf

Hardware Requirements for UltraScale Devices

e The hardware power measurements in UltraScale devices
(needed in Lab 4: Measuring Hardware Power Using the KCU105 Evaluation Board), require a
Xilinx Kintex® UltraScale FPGA KCU105 Evaluation Kit. You can find information on the
Evaluation Kit at the following location:

Xilinx Kintex® UltraScale FPGA KCU105 Evaluation Kit

e For power measurements through Maxim Digital Power Tool
(needed in Lab 4: Measuring Hardware Power Using the KCU105 Evaluation Board), use the
Maxim Power interface adapter.

You can find information on the interface adapter at the following location:

www.maximintegrated.com/en/products/power/power-switching/MAXPOWERTOOLO002.html

Power Analysis and Optimization www.xilinx.com 6
UG997 (v2018.3) December 5, 2018 Send Feedback


http://www.xilinx.com/
https://www.xilinx.com/cgi-bin/docs/rdoc?v=2018.3;t=vivado+release+notes
https://www.xilinx.com/products/boards-and-kits/ek-k7-kc705-g.html
http://www.ti.com/lit/ml/sllu093/sllu093.pdf
https://www.xilinx.com/products/boards-and-kits/kcu105.html
http://www.maximintegrated.com/en/products/power/power-switching/MAXPOWERTOOL002.html
https://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG997&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Power%20Analysis%20and%20Optimization&releaseVersion=2018.3&docPage=6

v
iA XI I_I NX Power Analysis and Optimization Tutorial

Locating Tutorial Design Files

1. Download the reference design files from the Xilinx website:
ug997-vivado-power-analysis-optimization-tutorial.zip
2. Extract the zip file contents into any write-accessible location.

This tutorial refers to the location of the extracted ug997-vivado-power-analysis-
optimization-tutorial.zip file contents as <Extract Dir>.

ﬁ IMPORTANT: You will modify the tutorial design data while working through this tutorial. Use
a new copy of the original data each time you start this tutorial

The ug997-vivado-power-analysis-optimization-tutorial .zip file includes a readme file
which contains the details and version history of the design files along with the folders of 7 series and
UltraScale design files.

7 Series Tutorial Design Files

You can find a separate 7 series folder containing the 7 series tutorial design files in the contents of the
zip file.

The following table describes the contents of the 7 series tutorial design files:

Directories/Files Description

/src Contains the design HDL and testbench for the functional
simulation.

/src/dut_fpga.v Top module for the design.

/src/bram_tdp.v Other design blocks - synthesized module.

/src/bram_top.v

/src/dut.v

dut_fpga_kc705.xdc Contains clocking and timing constraints for the design.

/src/testbench.v Testbench for simulating the design.

UltraScale Device Tutorial Design Files

You can find a separate UltraScale folder containing the UltraScale device tutorial design files in the
contents of the zip file.

The following table describes the contents of the UltraScale device tutorial design files:

Directories/Files Description
/src Contains the design HDL and testbench for the simulation.
/src/dut_fpga.v Top module for the design.
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Directories/Files Description

/src/dut.v
/src/Cascade_bram.v
/src/Noncascade_bram.v
/src/bram_top_cascade.v Other design blocks.
/src/bram_top_noncascade.v
/src/bram_tdp_cas.v
/src/bram_tdp_noncas.v

dut_fpga_kcul05.xdc Contains clocking and timing constraints for the design.

/src/testbench.v Testbench for simulating the design.
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Lab 1: Running Power Analysis in the Vivado
Tools

Introduction

In this lab, you will learn about the Power Analysis and Optimization features in the Vivado® IDE. The
lab will take you through the steps of project creation and power analysis at the synthesis stage, using
the Vivado Report Power feature in vectorless mode. It will also demonstrate using the SAIF file
generated from behavioral simulation for Vivado Report Power Analysis.

You will analyze power in the Vivado IDE. Then you will examine some of the major features in the
Power Report window and closely examine some power specific Tcl commands. You will also learn to
create a SAIF file by simulating the design in the timing simulation stage using both the Vivado
simulator and Questa Advanced Simulator.

You will also learn how to achieve Power Optimization after opt_design in the Vivado IDE. You will
examine the power optimization report and selectively turn power optimizations ON or OFF on specific
signals, nets, modules, or hierarchy.

Step 1: Creating a New Project

To create a project, use the New Project wizard to name the project, to add RTL source files and
constraints, and to specify the target device.

Note: Throughout this tutorial, Xilinx® 7 series example design is used to explain the process of
configuring, implementing, estimating the power through different stages, and using simulation
data to enhance the accuracy of the power analysis. For UltraScale™ device design, most of the
steps are similar to 7 series. Additional information, wherever necessary, is provided for UltraScale
devices.

e On Linux,

1. Go to the directory where the lab materials are stored:

cd <Extract Dir>/7_series (for 7 series devices)

or
cd <Extract _Dir>/UltraScale (for UltraScale devices)

2. Launch the Vivado IDE: vivado
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¢ Vivado 2018.1 - O X

File Flow Tools Window Help Q- Quick Access

VIVADO' & XILINX

ALL PROGRAMMABLE .

HLx Editions

Recent Projects

Quick Start prject.1

C:/Usersivenkatas/project_1
Create Project >

Open Project »

Open Example Project >

Tasks

Manage IP >
Open Hardware Manager >
Xilinx Tcl Store »

Learning Center

Documentation and Tutorials > -

| Tl console

Figure 1: Vivado IDE - Getting Started Page

e On Windows,
3. Launch the Vivado IDE:
Start > All Programs > Xilinx Design Tools > Vivado 2018.x > Vivado 2018.x
(x denotes the latest version of Vivado 2018 IDE)
4. As an alternative, click the Vivado 2018.x Desktop icon to start the Vivado IDE.

The Vivado IDE Getting Started page contains links to open or create projects and to view
documentation.

5. In the Getting Started page, click Create New Project to start the New Project wizard.

6. Click Next to continue to the next screen.
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¢ Mew Project

Project Name
Enter a name for your project and specify a directory where the project data files will be stored. ﬂ

Project name: power_tutoriall

¥'| Create project subdirectory

Project will be created at: C:ivivado_power_tutorialipower_tutorial1

Project location: | C:vivado_power_tutarial III

Figure 2: Creating a New Project

7. In the Project Name page, name the new project power_tutoriall and enter the project location
(C:\Vivado_Power_Tutorial). Make sure to check the Create project subdirectory option and

click Next.

8. In the Project Type page, specify the type of project to create as RTL Project, make sure to
uncheck the Do not specify sources at this time option, and click Next.

9. In the Add Sources page:
a. Set Target Language to Verilog and Simulator language to Mixed.
b. Click the Add Files button.

c. Inthe Add Source Files dialog box, navigate to the <Extract_Dir>/7_series/src

directory for 7 Series devices or <Extract_Dir>/UltraScale/src for UltraScale devices.

d. Select all of the Verilog (-V) source files, and click OK.

e. Inthe Add Sources page, change the HDL Source For the testbench.vV file to Simulation

Only.
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¢ Mew Project @

Add Sources

Specify HDL, netlist, Block Design, and IP files, or directories containing those files, to add to your project. Create a new source ’
file on disk and add itto your project. You can also add and create sources later.

+,
Index Mame Library HOL Source For Location
w1 bram_tdpw  xil_defaulllic  Synthesis & Simulation = Civivado_power_tutorial/7_seriesisrc
w2 bram_topwv  xil_defaultlip  Synthesis & Simulation =  C:vivado_power_tutorial/y_seriesisrc
w3 dutv ¥il_defaultlip  Synthesis & Simulation = C:nvivado_power_tutorial/7_seriesisrc
w4 dut_fpgaw ¥il_defaultlib  Synthesis & Simulation = Coivivado_power_tutorial/7_seriesisrc
@ 5 testbenchy  xil_defaultlip  Simulation only *  Cihivado_power_tutorial/7_seriesisrc
Add Files | | Add Directories | | Create File

Scan and add RTL include files into project
Copy sources into project

Target language: | Verilog w Simulator language: | Mixed A4

Figure 3: Setting HDL Source Type for testbench.v (7 Series)

f.  Verify that the files are added and Copy sources into project is checked. Click Next.
10. In the Add Existing IP (optional) dialog box, click Next.

11. In the Add Constraints (optional) dialog box, click Add Files and select dut_fpga_kc705.xdc in
the file browser. In the directory structure, you will find the dut_fpga_kc705.xdc file below the
/src folder.

For UltraScale devices, select dut_fpga_kcul05.xdc in the file browser. In the directory
structure, you will find the dut_fpga_kcul05.xdc file below the /src folder.

12. Click Next to continue.

13. In the Default Part dialog box, click Boards to specify the board for the target device and select
Kintex-7 KC705 Evaluation Platform for 7 Series or Kintex-UltraScale KCU105 Evaluation
Platform for UltraScale devices. Then click Next.
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Lab 1: Running Power Analysis in the Vivado Tools

TIP: When you specify a Board, you are also specifying the part you are targeting for your
design, in this case an xc7k325tffg900-2 FPGA for 7 Series or xcku040-ffva156-2-e FPGA for

UltraScale devices.

14. Review the New Project Summary page. Verify that the data appears as expected, per the steps

above, and click Finish.

Note: It might take a moment for the project to initialize in the Vivado IDE.

#  power_tutoriall - [Ci/vivado_power._tutorial/power_tutoriall /power._tutoriall xpr] - Vivado 20171

Eile Edit Flow Tools Window Layout View Help | A~ Quick Access
=, > B B =
Flow Navigator C3 B S PROJECT MANAGER - power_tutorialt

~ PROJECT MANAGER
£} Setlings

Add Sources

Sources ? 00X
a T & + o

> Design Sources (1

Project Summary

Settings  Edit
Language Templates
¥ P Catalog N

> Simulation Sources (1)

> @& dut_fpga (dui_fpgav) (1 Project name

Constraints (1 Project location:

Product family:

<

=5 Ho =
Ready

Default Layout ~

200X

power_tutorial1
C:Nivado_power_tutorial/ipower_tutoriall
Kintex-7

v PROGRAM AND DEBUG

¥ Generate Bitstream

> OpenHardware Manager <

IP INTEGRATOR Project part: Kintex-7 KC705 Evaluation Platform (xc7k325tfg900-2)
Create Block Design Top module name: dul_fpga
Open B Target language Verilog
Hierarchy  Libraries Compile Order Simulator language: Wixed
Generate B Desigr
Properties ? 00X
v SIMULATION BoaniPart
o
Run Simulation Display name: Kintex-7 KC705 Evaluation Platform
Board part name: xilinx.com:kc705:part0:1.5
v RTL ANALYSIS Conneclors
> Open Elaborated Design Select an object to see properties path: R: 17.1_daily_| 017. | files
URL: www xilinx. com/kc705 p .
v SYNTHESIS Board overview: Kintex-7 KC705 Evaluation Platform v
>
P Run Synthesis
> Open Synthesized Design Tcl Console Messages Log Reports Design Runs X ? 00
Q = % + %
v IMPLEMENTATION
Name Constraints ~ Status WNS TNS WHS THS TPWS Total Power FailedRoutes LUT FF BRAMs URAM DSP Stat Elapsed Strategy
P Run Implementation
~ synth_1 constrs_1 Mot started Vivado Synthesis Defaults (Viva
> Openimplemented Design impl_1  constrs_1 Mot started

Vivado Implementation Default:

Figure 4: Project in Vivado IDE (7 Series)

15. In the Vivado Options dialog box (Tools > Settings > Tool Settings> Project), enter the tutorial
project directory in the Specify project directory box, so that all reports are saved in the tutorial

project directory. Then click OK.
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s Settings 5
Project
Project Settings Specify various settings related to projects. ‘
{71 T - 1 e
Simulation Default Project Directory
Elaboration
Synthesis Start in directory (C:/Usersivenkatas)
Implementation Last projects directory
Bitst
fistream Home directory (C:/Usersienkatas)
AP
# Specify project directory: C:Ipr0j| B
Tool Settings
Projed Target Language
IP Defaults
Source File & Verilog VHDL
Display
Recent
WebTalk
Help Reopen last project on startup
> Text Editor Number of recent projects to list 10 =
3rd Party Simulators
s Colors Number of recent directories talist | 15 2
Selection Rules Mumber of recent files to list 10 2
Shortcuts
Strategies

» Window Behavior

)
(\2) ‘ Cancel ‘ ‘ Apply ‘ ‘Bestore...

Figure 5: Setting the Project Directory

Now, the design is ready for Synthesis.
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Lab 1: Running Power Analysis in the Vivado Tools

Step 2: Synthesizing the Design

1. Click Run Synthesis in the Flow Navigator. In the Launch Runs Dialog box that appears click OK.

¢ Launch Runs

Launch directory: | k0 =Default Launch Directory=

Options
#® Launch runs on local host:  Mumber of job

Generate scripts only

Don't show this dialog again

Launch the selected synthesis orimplementation runs.

s 4

Ex5

y

b

Cancel

Figure 6: Launch Runs Dialog

Box

2. The Synthesis Completed dialog box appears after synthesis has completed on the design.

Synthesis Completed

Hext
Run Implementation
@ Open Synthesized Design

View Reports

Dont show this dialog again

0 Synthesis successfully completed.

(=]

Cancel

-

Figure 7: Synthesis Completed Dialog Box

3. Open the synthesized design by selecting Open Synthesized Design in the Synthesis Completed

dialog box and clicking OK.
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Step 3: Setting Up the Report Power

The Vivado IDE allows you to specify input data to the Report Power tool to enhance the accuracy of
the power analysis.

In the Vivado IDE, you can configure thermal, environmental, and power supply options to mimic the
board level settings as closely as possible. For information on setting these options, see the Vivado
Design Suite User Guide: Power Analysis and Optimization (UG907).

1. In the main menu bar, select Reports > Report Power.

2. Examine the Environment tab in the Report Power dialog box (Figure 8).
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¢ Report Power @
Estimate power consumption based on the netlist design and part xcku040-ffva1156-2-e.
Results name: power_1
Environment  Power Supply Switching Dutput
Device Settings A
Temp grade:
Process: maximum w
Environment Settings
Cutput Load: 0 : pF [0 -10000]
Junction temperature: 25679 °C
Ambient temperature: 25 : C
Effective SJA: 1.42 “C/AV [0-100]
Adrflow: 250 w  LFM
Heat sink: medium (Medium Prof... w
IEA "CMW [0 -100]
Board selection: medium (107%107) W
Mumber of board layers: 121015 (12 t0 15 Layer... w
21B: "CMW [0 -100]
< M mrd fomne o re LILEE B cc Ann , e
Legend
User Defined Calculated Default
'i':?:' Cancel

Figure 8: Report Power Dialog Box (Environment Tab)
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Lab 1: Running Power Analysis in the Vivado Tools

3. In the Environment tab, set Process to maximum for a worst case power analysis. Examine the

Power Supply tab (Figure 9).

IMPORTANT: By default, Vivado Report Power uses nominal values for voltage supply sources.
Voltage is a large factor contributing to both static and dynamic power. For the most accurate
analysis, ensure that actual voltage values are entered for each supply. Similarly, ensure
temperature and other environmental factors match actual operating conditions.

¢ Report Power

Settings
Wecint:
Weocax
Weoodd:
Weooozh:
Veoods:
Weco15:
Woco135:
Weoco12:
Weocaux_io:
Vecbram:
MGTAVCC
MGTAWV:
MGTVccaux:

MGTZVecl:

Legend

User Defined

Results name:  power_1

1.000

1.800

3.300

2.500

1.800

1.500

1.350

1.200

1.800

1.000

1.000

1.200

1.800

1.075

Estimate power consumption based on the netlist design and part xc7vwd85tfg1157-1.

Environment Power Supply Switching Output

i
=
[_J

-l

L
=
=~
o
(=]

Sl ) - 2 450
2l v [2380-2630)
2V [1.710-1.900]
v [1.430-1580)
2V [1.300-1.400]
2V [.140-1.260]
2V [.710-1.390]
SV ).970-1.030
: v [0.850 - 1.050
2V [1.140-1260
2V [.710-1.390]
2V [.050-1.100]
Calculated Default

=

Figure 9: Report Power Dialog Box — Power Supply Tab
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4. In the Switching tab, expand Constrained Clocks and examine the constrained clocks in the design
(Figure 10).

IMPORTANT: Make sure all the relevant clocks in the design are constrained. All the design
clocks must be defined using create_clock or create_generated_clock XDC
constraints, so that Report Power recognizes the clocks.

Default toggle rate is set to 12.5% and Default Static Probability is set to 0.5. This will be
applied to primary input ports (non-clock) and block box outputs.
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¢ Report Power @

Estimate power consumption based on the netlist design and part xc7k325tfg900-2.

Results name: | power_1

Environment Power Supply Switching Output
Simulation Settings -~

Simulation activity file { saif): | | |E|

Default Activity Settings
Default toggle rate: 125 | [0-100]

Drefault Static Probability: 05| [0.0-1.0]

Enable Rate Settings

Static Probability Toggle Rate
BRAM Port Enable: [0.0-1.0] [0-100]
BRAM Write Enable: [0.0-1.0] [0-100]
Bidi Cutput Port Enable: [0.0-1.0] [0 -100]
Toggle Rate Settings
Static Probability Toggle Rate
Primary Qutputs: [0.0-1.0] [0 -100]
Logic
Registers: [0.0-1.0] [0-100]
Shift Registers: [0.0-1.0] [0 - 100]
Distributed RAMs: [0.0-1.0] [0-100]
LUTs: [0.0-1.0] [0-100]
DSPs: [0.0-1.0] [0 - 100]
Block RAMs: [0.0-1.0] [0-100]
GTs
RX Data: [0.0-1.0] [0 - 100]
TX Data: [0.0-1.0] [0-100]
~ Constrained Clocks
Clock Period
sys_clk_in_p 5ns
clk_0 5ns
clkoutD 10ns

-

@
Figure 10: Report Power Dialog Box — Switching tab expanded to display Constrained Clocks
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5. In the Output tab of Report Power dialog box, specify the Output text file as power_1_pwr.

6. Specify the Output XPE file as power_1.xpe. After creating this file when Report Power runs, you
can import the file and results into the Xilinx Power Estimator (XPE). For information on importing
the file in to the Xilinx Power Estimator (XPE), see the Xilinx Power Estimator User Guide (UG440).

7. Specify the RPX file to write the results of the Report command in to the specified report file (RPX).
The saved RPX file can be reloaded using the Reports > Open Interactive Report command to
provide interaction/cross-probing with the open design.

# Report Power @

Estimate power consumption based on the netlist design and part xc7k325tfg900-2.

Results name:  power_1

Environment | Power Supply | Switching | Qutput
Cutput text file: power_"1.pwr B
Cutput XPE file: power_1.xpe E
¥ Qutput RPX file: | Ciprojfpower_1.rpx |E

Figure 11: Report Power Dialog Box (Output Tab)
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Legends in Report Power Tool

The following legends appear consistently in the Report Power tool:

Constraint Displays when the Nets are defined as clock with timer constraints.
The defined frequency of a clock determines the switching activity.

Simulation Displays when the Nets with switching activities are derived from
simulation’s .saif file

User Defined Displays when the Nets with user set switching activities are
derived from set_switching_activity power tcl command.

Estimated Displays when the Nets with switching activities are generated by
report_power vectorless propagation engine.

Default Displays when the Nets include default switching activities. If you
use set_switching_activity on input port nets or on internal nets
before running report_power (vectorless propagation), the report
tool displays the default.

Step 4: Running Report Power

1. Click OK on the Report Power dialog box.
This runs the report_power command.

2. Examine the Power Report power_1 generated in the Power tab of the results windows area in the
Vivado IDE.

TIP: Due to continuous accuracy improvements in the Vivado tools, the actual power numbers
you see might be slightly different than the ones that appear in the following figures.
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Power ? _0&aXx
Q T £ C MW7  summay
Seftings N ; ) . i
Power estimation fram Synthesized netlist. Activity ‘On-Chip Power
Summary (1.379 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Note: these early estimates can Dynamic: 0.918'W
+ Utilization Details change after implementation.
Hierarchical (0.915 W) Total On-Chip Power: 1379 W e Clocks: poTTw
. Signals: 0.061W
Clocks (0.011W) Junction Temperature: 274°C
- P Logic oomw
Signals (0.057 1) Thermal Margin 57.6°C (30.3W) -
(0.061 W) BRAM: 0714w
Data (0.061 ) Effective S.A 18T !
Clock Enable (0 W) W MMcm: 0117 W
o Power supplied to off-chip devices: 0W
SetiReset (0 W) 1o: 0.004 W
Logic (0.0171 W) Confidence level: Medium 33%
A Advi ] !
BRAM (0.714 W) Launch Power Constraint Advisor to find and fix Device Static 0461 W

invalid switching activity
Clock Manager (0,117 W)

WO (0.004 W)

Figure 12: Power Report

3. Examine the power breakdown in the Power Report by block type (Logic, BRAM, 1/0, etc.).

4. Examine the power supply breakdown in the Power Supply view.

Power ?_0ax
Q T £ C W 7 Powersupy Default | | Calculated
Settings Supply Source  Voltage (V)  Total (A) Dynamic (A)  Static (A)
Summary (1373 W) Veaint 1.000 1041 0745 0296
Vecaux 1,800 0152 0.067 0.085
~ Utilization Details Veco33 3.300 0042 0.000 0042
Hierarchical (0.973 W) Veco25 2500 0.000 0.000 0.000
Clocks (0.011W Veeolg 1800 0000 0.000 0000
~ Signals (0.06 Veco 15 1500 0000 0.000 0000
Data (0.061 W) Veco135 1350 0000  0.000 0000
Clack Enable (0W) Veco 12 1200 0000 0.000 0.000
SetReset (01) Vecaux_io 1800 0000  0.000 0.000
Logic (0.011 W)
gl Vecbram 1.000 0066  0.054 0013
BRAM (0.714 W)
MGTAVCE 1.000 0000  0.000 0000
Clock Manager (0 117 W)
MGTAVE 1200 0000  0.000 0.000
/O (0.004 W)
MGTVccaux  1.800 0000  0.000 0.000
Vecade 1800 0030  0.000 0030
power_1

Figure 13: Power Report — Power Supply Display

5. Examine the Hierarchical breakdown of the power in the Utilization Details > Hierarchical view.
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Lab 1: Running Power Analysis in the Vivado Tools

Seftings

Summary (1
Power Supply
~ Utilization Details

ierarchical (0.918 W)

Clock Enable (0W)
SetReset (0W)
Logic (0.011W
BRAM (0.714 W)
Clock Manager (0,117
g o

Q =

Utilization

Hierarchical

~ [ (0.918 W (67% of total)
~ [ 0.795 W (58%

W 0.079 W (6% of total)
W 0.079 W (6% of tofal

W 0.079 W (6% of total)
B 0.079 W (6% of total)
W 0.079 W (6% of tofal)
W 0.079 W (6% of total)
H 0.079 W (6% of total)
B 0.079 W (6% of total)
H 0.079 W (6% of total

W 0.079 W (6% of total)
1=0.001W (=
E0.124 W (

of total)

Name
3 dut_fpga
dut (dut)

gen_dut{0].br...

en_dut[1] br
en_dut[Z].br.

en_dut[5].br.

gen_dut{9] br.
Leaf Cells (6)
LeafCells (18)

en_dut[3].br...
en_dut[4].br...

en_dut[G].br...
en_dut[7].br...
en_dut[8].br...

Clocks (W)

0.009
0.001
0.001
0.001
0.001
0.001
0.001
0.001
0.001
0.001
0.001

Signals (W)

0.061
0.006
0.006
0.006
0.006
0.006
0.006
0.006
0.006
0.006
0.006

Data (W)

0.061
0.006
0.006
0.006
0.006
0.006
0.006
0.006
0.006
0.006
0.006

Logic (W)

0.011
0.001
0.001
0.001
0.001
0.001
0.001
0.001
0.001
0.001
0.001

BRAM (W)

0.714
0.071
0071
0.071
0.071
0.071
0.071
0.071
0.071
0.071
0.071

? _0a&a X

Clock Manager (W)  MMCM (W)  1/O (W)
=0.001 =0.001 =0.001
=0.001 =0.001  =0.001
=0.001 =0.001 =0.001
=0.001 =0.001  =0.001
=0.001 =0.001  =0.001
=0.001 =0.001  =0.001
=0.001 =0.001 =0.001
=0.001 =0.001  =0.001
=0.001 =0.001  =0.001
=0.001 =0.001  =0.001
=0.001 =0.001  =0.001

6.

Figure 14: Power Report — Hierarchical Display

Examine the Clocks view and the various Signals views (Data, Clock Enable, and Set/Reset).

Power ? -0a X
Q T £ C H " QO T Cocks Constraint Calculated
Settings Utilization Mame Frequency (MHz) Buffer Clock Buffer Enable (%) Enable Signal Bel Fanout Sites FanouliSite  Type
Summary (1.379 W) ~ I0.0MTW( 5 dut_fpga
Power Supply > 10.009W (1% of total) T clkoutd 100000 NiA NIA - NIA 242 61 1378 NA
~ Utilization Details » 10.002W (1% of total) I clk 0 200.000 NiA Ni& NIA 2 2 1.000 MNA
Hierarchical (0.815 W) > 1<0.001W (=1% of total) oI sys_clk_in_p 200.000 NiA Nia NIA 2 2 1.000 NA
locks (0.011 W)
~ Signals (0
Data (0.0671 W)
Clack Enable (0
SetReset (0 W)
Logic (0.011 W
BRAM (0.714 V
Clack Manager (0,117 W)
power_1
Figure 15: Power Report — Clocks Display
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Step 5: Viewing the Power Properties

This step will show you how you can get the display of static probability and toggle rate for a signal in
property window.

1. Note the total power (Total On-Chip Power) in the Power Report Summary view.
2. Click the Set/Reset item in the Power Report.
3. Click on the dut/dut_reset signal.

Power ?-0aX

Q T 2 C W 7 QO T setReset Aftribute Estimated Calculated

Settings Utilization ~ Name Signal Rate (WMir/s) % High  Fanout Slice Fanout Clock  Logic Type
Summary (1.379 ~ 0w 5 dut_fpaa
Power Supply ow I dut'dut_reset 0.000 0.000 530 0 clkoutd FFLUT
~ Utilization Details ow I led_OBUF 0.000 100.000 3 0 clkoutd FFUOLUT
Hierarchical (0.918
Clocks (0.011 W)

(0.061 W)
Clock Enable (0W)
Logic (0.011W)

BRAM (0.714 W)

Clock Manager (0117 W)
110 (0.004 W

Figure 16: Power Report — Set/Reset Display

4. Note that there is a Power tab in the Net Properties window, displaying Net Properties for the
dut/dut_reset signal. Click on Load Power Properties to get the power information the first time.

Net Properties ? -0 a X
I dut_reset &
QOutput

Togagle rate: 0.0 %

Static probability: 0.0

Legend: Estimated

Edit Properties...

General Properties Connectivity Power  Aliases Cell Pins  MNodes  Tiles Pips

Figure 17: Properties Window - Set/Reset Net Properties

5. Note the Toggle rate is 0% and the Static probability is O for the dut/dut_reset signal, which
indicates that Reset is always de-asserted in the design.
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Step 6: Editing Power Properties and Refining the Power
Analysis

Assume the Reset is asserted for 10% of the cycles in this design. Switching activity can be set
accordingly to re-estimate the power.

1. In the Net Properties window, click the Edit Properties button.

2. In the Edit Power Properties dialog box, change the Toggle rate to 4% and the Static probability
to 0.1.

¢ Edit Power Properties @
Set power properties for dut_reset. ‘
Qutput
Toggle rate: 4000 | %

Static probability: [0.0-1.0]

Figure 18: Edit Power Properties Dialog Box

3. Click OK.

4. In the Net Properties window, observe that the Toggle Rate and Static Probability values turn a
different color to indicate that they are user defined.
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Net Properties ? - 0a X
I dut_reset -3
QOutput

Toggle rate: 40 %

Static probability: 01

Legend: User Defined

Edit Properties...

General Properties Connectivity Power Aliases CellPins  Modes  Tiles Pips

Figure 19: User Defined Color in Net Properties Window

You can also observe the equivalent Tcl command executed in the Tcl Console.

Tcl Console ® Messages Log Reports Design Runs Power ?_00
a =z £ Il 8 B @

| Command: report_power -file C:/Users/in/power_1.pwr —upe C:/Users/im/power_1.xpe -rpx C:/proi/power_l.rpx -name power_1
. Running Vector-less Activity Propagation...

E Finished Running Vector-leas Actiwvity Propagation

! 0 Infoa, 0 Warninga, 0 Critical Warnings and 0 Errora encountered.

i report_power completed successfully

E set_switching_activity -toggle_rate 4.000000 -atatic_prebability 0.100000 [get_nets dut/dut_reset]

Figure 20: Equivalent Tcl Command for Net Property Update

5. Rerun Report Power (Reports> Report Power).

6. Change the Output text File and Output XPE File in the Output tab to power_2.pwr and
power_2 .xpe respectively.

7. In the Switching tab, set Switching Activity for Resets: to None. Then click OK.

8. In the Power window, note the change in total power reported in the power_2 report compared to
the power_1 report. The total power has decreased due to the change in the Signal Rate for the
dut/dut_reset signal. Since the signal is a reset signal, an increase in its activity will significantly
reduce the activity of other signals in the design. Note that the Signal Rate of the dut/dut_reset
signal is now color coded as being User Defined in both the properties window and the Set/Reset
view of the Power Report.
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Tcl Console Messages Log Reports Design Runs Power X 2 _00

Q T & C H Q I SetiReset User Defined Attribute Calculated

Settings Utilization Name Signal Rate (Mtr/s) % High Fanout  Slice Fanout Clock Logic Type
Summary (1 358 v 1<0.001W (=1% of total) 5 dut_fpaa
Power Supply 1<0.001W (<1% oftotal) | dutidut_reset 4.000 10.000 530 0 clkoutd FFLUT

~ Utilization Details ow oI led_OBUF 0.000 100.000 3 0 clkoutd  FFUOLUT
Hierarchical (0.598

Clocks (0.011

Clock Enable (0w
Logie (0.01 W
BRAM (0.7
Clock Manager (0.117 W)
1O (0.004 1

power_1 *  power_2 X

Figure 21: Power Report — User Defined Signal Rate

Xilinx recommends you to double-check the signal rates and percentage high (%high) values of high
impact 1/O ports, control signals (such as resets and clock enables) and high fanout nets. This is an
opportunity to guide the Report Power tool to the right estimation scenario.

See the Vivado Design Suite User Guide: Power Analysis and Optimization (UG907) for more information
on switching activity.

TIP: In Tcl, use the set_switching_activity command to change the signal rate and static
probability of signals and use report_switching_activity to query the values that were
set on the signals.

set_switching_activity -signal_rate 4 -static_probability 0.1 [get_nets dut/dut_reset]
report_switching_activity [get_nets dut/dut_reset]

IMPORTANT: Switching activity can also be specified in terms of toggle rate. Toggle rate is
always associated with a clock. The primary ports can be associated with a specific clock using
the set_input_delay and set_output_delay commands. If no clock association is found,
Report Power will associate the ports with respect to the capturing clock.

For a clock of 100 MHz and a toggle rate of 4, the equivalent signal rate will be 4 MTr/s
(signal_rate = toggle_rate * Freq = 4 * T00MHz ).
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Step 7: Running Functional Simulation with SAIF Output

Now that you have created a Vivado Design Suite project for the tutorial design, you can set up and
launch the Vivado simulator to run post-synthesis functional simulation. Simulation will generate a
switching activity values file (SAIF) that will enable you to do more accurate power estimation on your
design.

1. In the Flow Navigator, click Settings to open the Project Settings dialog box and set the simulation
properties in Simulation section.

2. In the Simulation section of Project Settings dialog box, note that the following Simulation defaults
are automatically set for you based on the design files:

Simulator language: Mixed
Simulation set: sim_1
Simulation top-module name: testbench

3. In the Elaboration tab of Simulation, make sure the xsim.elaborate.debug_level is set to typical,
which is the default value.
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P -

¢ Settings @
Simulation
Project Settings Specify various settings associated to Simulation ‘
General
Simulation Target simulatar: Vivado Simulator v
Elaboration
. Simulator language: Mixed v
Synthesis
Implementation Simulation set: = sim_1 v
Bitstream ) )
P Simulation top module name: | testbench E
] ~'| Clean up simulation files
Tool Settings
Project
IP Defaults Compilation Elaboration Simulation Netlist | Advanced
Source File
i xsim.elaborate snapshot
Display
xsim.elaborate.debug_level ical w
WebTalk 9 P
Help xsim.elaborate.relax +
s Text Editor xsim.elaborate.mt_level auto hd
3rd Party Simulators xsim.elaborate.load_glbl <
» Colors xsim.elaborate-rangecheck
Selection Rules ¥sim.elaborate.sdf_delay sdfmax w
Shortcuts xsim.elaborate xelab.more_options
Strategies
» Window Behavior

Select an option above to see a description of it

o | [om

Figure 22: Simulation Settings - Elaboration Tab

4. In the Simulation tab enter the SAIF file name as power_tutorial_func.saif for
xsim.simulate.saif. Observe that the xsim.simulate.runtime is 1000ns.

5. Click OK.
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§  Settings

Project Settings

¥

General
Simulation
Elaboration
Synthesis
Implementation
Bitstream

IP

Tool Settings

L

b

With the simulation settings properly configured, you can launch the Vivado simulator to perform a

Project

IP Defaults
Source File
Display

WebTalk

Help

Text Editor

3rd Party Simulators
Colors

Selection Rules
Shortcuts
Strategies
Window Behavior

Simulation

Lab 1: Running Power Analysis in the Vivado Tools

Specify various settings associated to Simulation

Target simulator:
Simulator language:

Simulation set:

Simulation top module name:

Vivado Simulator
Mixed
= sim_1

testbench

<+ Clean up simulation files

Compilation

Elaboration

Simulation Netlist Advanced

xsim.simulate.tcl. post

x¥sim.simulate.runtime

1000ns

¥sim.simulate.log_all_signals

¥sim.simulate.custom_tcl

¥sim.simulate.wdb

¥sim.simulate saif_scope

¥sim.simulate.saif

power_tutorial_func.saif

¥sim.simulate.saif_all_signals

¥sim.simulate xsim.more_options

xsim.simulate.saif

SAIF filename

0K ‘ | Cancel ‘ ‘

Apply | ‘Bestore._.

Figure 23: Simulation Settings — Entering SAIF File Setting

post-synthesis functional simulation of the design.

Note: The power reporting and analysis are not performed at the RTL level. They are performed at

the gate level.
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6. In the Flow Navigator, click Run Simulation > Run Post-Synthesis Functional Simulation.

¥ SIMULATION
Run Simulation

Run Behavioral Simulation

L [
RTL ANALYSH Run Post-Synthesis Functional Simulation

» OpenElat Run Post-Synthesis Timing Simulation

» SYNTHESIS
P Run Synthl__._

Figure 24: Running Post-Synthesis Functional Simulation from Flow Navigator

When you launch the Run Post-Synthesis Functional Simulation command, the Vivado simulator is
invoked to run the simulation.

SIMULATION - Post-Synthesis Simulation - Functional - sim_1 - testbench

Scope Objects Untitled 1
Q= | % &« Q & O W a @ [ < I« M T &

Name Design Unit Block Type Name Value DataT.”™ 1,000,000 ns|"
~ 0 testbench testbench Verilog M. W sys_clk_p 0 Logic
> @ dut_fpga dut_fpga Verilog M. @ sys_clk_n 1 Logic —_—
—

@ gibl glbl Verilog M @ led 1 Logic

@ pass 1 Logic
> & WATCHDO 100000 Array

< >v- >

Figure 25: Post-Synthesis Functional Simulation Window in the Vivado IDE

After the simulation completes, click x at the top right corner to close the simulation window.

Step 8: Incorporating SAIF Data into Power Analysis

The SAIF output file requested in the simulation run is generated in the project directory. To further
guide the power analysis algorithm we use this SAIF file.

1. Ensure the SAIF file requested is generated. Check to see that the SAIF file requested in the
simulation settings prior to running simulation appears in this directory:
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<project_directory>/power_tutoriall/power_tutoriall.sim/sim_1/synth/
func/power_tutorial _func.saif

In the Flow Navigator window, click on Open Synthesized Design to expand options.
From the Synthesized Design options, select Report Power.

In the Report Power dialog box, set the Results name to power_3

v oA W

In the Output tab of Report Power dialog box, make the following changes:
0 Set the Output text File to power_3._pwr
0 Set the Output XPE File to power_3.xpe

6. In the Environment tab of Report Power dialog box, make sure that the Process is set to
maximum.

7. In the Switching tab of Report Power dialog box, specify the SAIF file location.

¢ Report Power 2

Estimate power consumption based on the netlist design and part xc7k325tfg800-2.

Results name: | power_3

Environment Power Supply Switching Output

Reset switching activity before report power

Switching Activity for Resets: | None v

Simulation Settings

Simulation activity file ( saif). (Isim_‘h’synthrfuncn’power_tutoria\_func.saif jz‘

Default Activity Settings
Defaulttogole rate: 125 | [0-100]

Default Static Probability: 05| [0.0-1.0]

Enable Rate Settings

Static Probability Toggle Rate
BRAM Port Enable: [0.0-1.0] [0-100]
BRAM Write Enable: [0.0-1.0] [0-100]
Bidi Output Port Enable: [0.0-1.0] [0-100]
Toggle Rate Settings
Static Probability Toggle Rate
Primary Outputs: [0.0-1.0] [0-100]
Logic
Registers: [0.0-1.0] [0-100]
Shift Registers: [0.0-1.0]

Plindribdnd DA~ thn 4t [

Figure 26: Specifying SAIF File Location
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8. Click OK in the Report Power dialog box.

The report_power command runs, and the Power Report power_3 is generated in the Power tab
of the results windows area.

? - 0aX
Q x 2 C H Summary
Settings . ) . B i
Power estimation from Synthesized netlist Activity On-Chip Power
Summary (1.332 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. MNote: these early estimates can Dynamic: 0.86IW (55%)
+ Utiization Details change after implementation.
Hierarchical (0 869 /) Total On-Chip Power: 1332w oo, Clocks: 000w (1)
Clocks (0.01 ) Signals 0043W (5%
Junction Temperature: 274°C
i 0.0 Logic 0.009wW  (1%)
~ Signals (0.0 Thermal Margin: B7.6°C(303W) g
(0.043 W) BRAM 0.685W (79%)
Data (00 Effeciive 3JA 18°Cw M Bra ‘
Clock Enable (<0.001W : ) M ucu OATW  (14%)
o Power supplied to off-chip devices: 0W
SetReset (<0 001 W) o 0.006W (D%
Logic (0.009 W) Confidence level High 35%
BRAM (0.685 W) Launch Power Constraint Advisor to find and fix —
. invalid switching activity Device Static: ~ 0.463W  (35%)
Clock Manager (0117 W
If0 (0.005 W)
< >

Figure 27: Power Report — Summary

Note: The SAIF annotation results are displayed in the Tcl Console. Make sure that all the design
nets are matched with simulation nets, to achieve better accuracy by including Simulation data.
For 7 series devices, the number of design nets and simulation nets may vary due to various
reasons. The most common reason s that their hierarchical separators are different. Sometimes,
the simulation nets may be lower down in the hierarchy level. However, they should match 100%.

Example: INFO: [Power 33-26] Design nets matched = 1894 of 1894

Tcl Console X Messages Log Reports Design Runs Power ?

a = £ 1

ned using
using sdc tim

INFO: [Power 33-26] Design nets matched = 1894 of 1894

, 1 Warnings, 0 Critical Warnings and 0 Errors enco
.| report_power completed successfully

G

Figure 28: Tcl Console Log - Reading SAIF Data

9. Go to the I/0 view in the Power Report. Note that all the I/O port activity data has been set from
simulation data we specified. The data is color coded to indicate activity rates read from the
Simulation output file.
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Lab 1:

Running Power Analysis in the Vivado Tools

Power ? - 0ax
Q = $ C HW Q T w Simulation Constraint Calculated
Settings MName li0 Type 10 Standard Drive Strength  InputPins  OutputPins  Bidir Pins Signal Rate
Summary (1.232 W) G dut_fpga
Power Supply [ sys_clk_in_p HP DIFF_SSTL. MIA 1 0 o 400.000
~ Utilization Details 1@ fmc_out HR LWCMOS33 12.000 0 10 1] 1.000
Hierarchical (0.569 W) 1<0.001W (1% oftotal) <@ gpio_out_pass HR LVCMOS33 12.000 0 1 o 1.000
Clocks (0.01W) 1<0.001W (<1% oftotal) @ led HP LVCMOS15 12.000 0 1 0 1.000
~ Signals (0.0
Data (0
Clock Enable 1w
SetReset (<0.001 W)
Logic (0.009 W)
BRAM (0.685 W)
Clock Manager (0117 W)
S 20 2]
power_1 X | power_2 X power 3 X

Figure 29: Power Report - 1/0 Display

10. Note the difference in total power numbers (Total On-Chip Power in the Summary view) between
a pure vectorless run in the power_1 results versus with the post synthesis functional simulation
data in the power_3 results. Also note that the dut/dut_reset signal rates are overwritten by
simulation SAIF data.

Hierarchical (0.559 W)

Clocks (0.0
~ Signals |
Data (0.043 W)

Clock Enable (=0 001W
Logic (0.009 W)
BRAM (0 685 W)
Clock Manager (0,117 W)
lQ (0.005 W

Power ?-0aXx
Q = & C H O, X SsetReset Simulation Calculated
Settings Utilization Name Signal Rate (Miris) % High Fanout Slice Fanout Clock  Logic Type
Summary (1.232 W) ~ 1=0.001 W (=1% oftotal) 5 dut_fpoa
Power Supply 1 <0001 W (=1% of total) I dutdut_reset 1000 26250 630 0 clkoutd  FFLUT
~ Utilization Details ow I led_OBUF 1000 73740 3 0 clkoutd FFUOLUT

Figure 30: Power Report — Set/Reset Display
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Lab 1: Running Power Analysis in the Vivado Tools

Step 9: Implementing the Design

This tutorial helps you understand Power Analysis with and without Power Optimization. In this step,

you will run Implementation without Power Optimization.

1.
2.

3.

Power Analysis and Optimization
UG997 (v2018.3) December 5, 2018

In the Flow Navigator, right-click on Implementation and select Implementation Settings.

In the Opt Design settings, select the NoBramPowerOpt option for —directive and click OK.

¢ Settings

Project Settings
General
Simulation
Elaboration
Synthesis
Implementation
Bitstream

> P

Tool Settings

Project

IP Defaults

Source File

Display

WebTalk

Help

Text Editor

2rd Parly Simulators
» Colors

w

Selection Rules
Shortcuts
Strategies

» Window Behavior

{.q :I &>

Implementation

Specify various settings associated to Implementation

Constraints

Default constraint set

Options

&= constrs_1 (active

¥ Run report UltraFast methodology after routing

Incremental compile:

(==

Strategy: £ Vivado Implementation Defaults* (Vivado Im... | |l
Description:
~ Opt Design (opt_design)
is_enabled +
tcl.pre E‘
tcl.post E‘
-verbose
-directive MoBramPowerQOpt |
More Options Explore
- Out Desi t dess Explorefrea
Power Opt Design (power_opt_design) c, ..o 0 entialtrea
is_enabled AddRemap
tel pre RuntimeQptimized ]
d ¢ MoBramPowerQOpt ]
tl.pos ExploreWithRemap
More Options Default
* Place Design (place_design) -
-directive
Opt design directive.
Ok ‘ ‘ Cancel ‘ ‘ Apply ‘ ‘ Restare...

Figure 31: Disabling Power Optimization

In the Flow Navigator, click Run Implementation.
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4. When prompted to Save project before launching implementation click Don’t Save.
¢ Save Project @

0 Save project before launching implementation®

Data to Save

+'| Synthesized Design - constrs_1 - dut_fpga_kcv705 xdc

g
@

Dont Save Cancel

Figure 32: Click “Don’t Save” Here

Conclusion

In Lab 1, you have learned how to set the power analysis in the Vivado IDE. In lab 2, you will learn
about the timing simulation and its effect on the power analysis.
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Lab 2: Running Timing Simulation and
Estimating Power

Introduction

In this lab, you will learn about generating a SAIF file after running a timing level simulation using the
Vivado® simulator and Questa Advanced Simulator. The lab will take you through the steps for SAIF file
creation, running timing simulation, and estimating power using the SAIF data.

Step 1: Configuring and Running the Timing Simulation using
Vivado Simulator

1. In the Implementation Complete dialog box, select Open Implemented Design and click OK to
open the implemented design. When prompted to Save project before opening an implemented
design, click Don’t Save.

Now you are ready to set up and launch the Vivado simulator to run post implementation timing
simulation. You will set the timing simulation properties in the Vivado IDE, then run the timing
simulation.

2. In the Flow Navigator, click Settings and select Simulation tab to set the timing simulation
properties.

3. In the Project Settings dialog box, note that the following defaults are automatically set:
Simulation set: sim_1
Simulation top-module name: testbench

4. In the Elaboration tab, make sure that debug_level is set to typical, which is the default value.

5. In the Simulation tab set the SAIF filename xsim.simulate.saif to
power_tutorial_timing xsim.saif.

6. Set the xsim.simulate.saif scope to testbench/dut_fpga.
7. Observe that the simulation run time xsim.simulate.runtime is 1000ns.

8. Click OK.
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Lab 2: Running Timing Simulation and Estimating Power

¢ Settings

Project Settings
General
Simulation
Elaboration
Synthesis
Implementation
Bitstream

> IP

Tool Settings

Project

IP Defaults

Source File

Display

WebTalk

Help

Text Editor

3rd Party Simulators

» Colors

-

Selection Rules
Shorcuts
Strategies

» Window Behavior

Simulation

Specify various settings associated to Simulation ‘

Target simulator:
Simulator language:

Simulation set;

Vivado Simulator A
Mixed A
i sim_1 w

Simulation top module name: | testbench

<+ Clean up simulation files

Compilation Elaboration Simulation Netlist | Advanced
xsim.simulate.runtime 1000ns
¥sim.simulate.log_all_signals® +

xgim.simulate.custom_tcl
x¥sim.simulate.wdb
xsim.simulate saif_scope

xXsim.simulate. saif*

testbenchidut_fpga

power_tutorial_timing_xsim.saif

SO SRR SR DU Y TS S

xsim.simulate.runtime
Specify simulation run time

==

| Cancel ‘ | Apply ‘ ‘ Restore...

Figure 33: Timing Simulation Settings — Simulation Tab

With the simulation settings properly configured, you can launch the Vivado simulator to perform a
timing simulation of the post implemented design.

9. In the Flow Navigator, click Run Simulation >Run Post-Implementation Timing Simulation.

~  SIMULATION

Run Simulation

Net Properties

Run Behavioral Simulation

¥ RTL ANALYS

Run Post-Synthesis Functional Simulation

» OpenElz

Run Post-Synthesis Timing Simulation

~  SYNTHESIS
P Run Synt

Run Post-lmplementation Functional Simulation

Run Post-lmplementation Timing Simulation

Figure 34: Running Post-Implementation Timing Simulation
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10. After the Vivado simulator has finished simulating the design, ensure that the SAIF file requested
has been generated. Check to see that the SAIF file requested in the simulation settings prior to
running simulation appears in this directory:

<project_directory>/power_tutoriall/power_tutoriall_sim/
sim_1/impl/timing/power_tutorial_timing_xsim.saif

SIMULATION - Post-lmplementation Simulation - Timing - sim_1 -testbench

Scope Objects Untitled 2
a = |= o Q o Q W @ @ X = 4 T &
Name Design Unit  Block Type Mame Value DataT.”™ 1,000 000 ns]|”™
~ 1} testbench testhench Werilog M W sys_clk_p 0 Logic
> 4@ dut_fpga dut_fpga Verilog M... b sys_clk_n 1 Logic —_—
@ aglbl albl Verilog W % led 1 Logic
5 @ WATCHDO.. 100000 Array f
~
< > >

Figure 35: Post-lmplementation Timing Simulation using the Vivado Simulator
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Step 2: Running Report Power in Vectorless Mode

1. In the Flow Navigator, select Open Implemented Design > Report Power to open the Report
Power dialog box.

You can also select Reports > Report Power from the main menu bar.

2. In the Report Power dialog box Environment tab, make sure the Process is set to maximum and
click OK.

The Report Power command creates a Power Report under the power_1 tab in the results windows
area.

3. Note the total power (Total On-Chip Power) in the power report Summary page (Figure 36).

Power ?_0aX
Q T £ C 7 summay
Settings .
g Power analysis from Implemented netlist. Activity On-Chip Power
Summary {1.545 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1.080W  (T0%)
~ Utilization Details
Total On-Chip Power: 1.545W Clocks: 0.022 W ot
Hierarchical (1.08 W) Junction T N R 21% : i
Clocks (0.022 W) unction Temperature: : 70% Signals:  0.223W  (21%
+ Signals Thermal Margin: 57.3°C(301W) Logic: 0.000W 1%
Data (0223 W) Effective 34 18w MIBRAM:  0705W (65%
Clack Enable (0 ) Pawer supplied fo off-chip devices: 0 W W MMCM:  0A1TW (1%
SebReset (=0.001 W Confidence level: Medium T 0ODAW (0%
Logic (0 Launch Power Constraint Advisor to find and fix St
BRAM (0.70 invalid switching activty Device Staic. ~ Q.465W  (30%)
Clock Manager (0117
/O (0.004 W)

Figure 36: Running Post-Implementation Report Power in Vectorless Mode

Vectorless Analysis is done based on default switching activity specification on the primary ports and
the design clocks.

Refer to the Vivado Design Suite User Guide: Power Analysis and Optimization (UG907) for more
information on Vectorless Power Analysis.
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Lab 2: Running Timing Simulation and Estimating Power

Step 3: Running Report Power with Vivado Simulator SAIF

Data

The project directory contains the SAIF output file requested in the previous timing simulation run. We
use this SAIF file — a "Switching Activity Interchange Format” file — to further guide the power analysis

algorithm.

1. In the main menu bar, select Reports > Report Power.

2. In the Report Power dialog box, specify the SAIF file location in the Switching tab.

The SAIF file, which was requested in the simulation settings prior to running timing simulation,
should appear here:

<project_directory>/power_tutoriall/power_tutoriall.sim/
sim_1/impl/timing/power_tutorial_timing _xsim.saif

3. Click OK in the Report Power dialog box.

After the Report Power command completes, the Power tab in the results windows area displays
Power Report power_2.

In the Tcl console, observe that the SAIF file is read successfully and that 100% of the design nets
are matched. This assures you that the generated SAIF file is correct and matched with all design

nets.

Power
a x s c
Settings
Summary (1485 W)
Power Supply
~ Utilization Details
Hierarchical (1.019
Clocks (0.021V
~ Signals (0.132W
Data (0.182 1
Clock Enable (=0.00
SetReset (<0.001 1
Logic (0.008
BRAM (0.685
Clock Manager (0.117
110 (0.005

4 >

impl_1 (saved)

® | power_1

Summary

Power analysis from Implemented netlist. Activity
derived from constraints files, simulation files or

vectorless analysis

Total On-Chip Power:

Junction Temperature:

Thermal Margin

Effective 3JA:

Power supplied to off-chip devices:

Confidence level

1485 W

276 °C
574°C(30.2W)
1.8Cw

ow

High

Launch Power Constraint Advisor to find and fix

invalid switching activity

*  power_2 ¥

On-Chip Power
Dynamic: 1.019 W
18% Clocks: 0.021W
69% Signals 0182w
Logic: 0.008 W
67% BRAM:
W mcu: 01T W
! 1o: 0.005W
3%
Device Static: DABEW  (31%

0B85W (67%

? - 0aXx

Figure 37: Power Report with SAIF Data

4. Note the change in total power (Total On-Chip Power in the Summary view) in the power_2
report compared to the power_1 report. The total power estimated in the report generated with
SAIF file data will be different than the total power estimated in the vectorless run (power_1 results).

5. Examine the summary and block level (On-Chip Power) power distribution in the Summary view of
the Power Report.
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6. Go to the Utilization Details > Signals >Data view in the Power Report. Note that all the Signal
Rate data has been set from simulation data the SAIF file provided.

The data is color coded to indicate activity rates read from the Simulation output file.

Power ? _0a X
Q x & C  Q I oDpata Simulation Calculated
Settings Utilization Name Signal Rate (Mir/'s) % High Fanout Slice Fanout  Clc
Summary (1.485 1) v EEO0182W(12% oftotal) G0 dut_fpga &
Power Supply 010.001 W (=1% ofto I dut/gen_dut{9] bram_top_instaddr_a[1] 73.000 63.935 34 34 ck
~ Utilization Details 10.001W (<1 T dutigen_duta].bram_top_inst/addr_b[11] 73000  36.049 4 34 ok
Hierarchical (1.0719 W) 10.004W (= T dutigen_dut[4].bram_top_instbram_instfmem_reg_2_0_i_2_n_0 74000 26.001 16 16 clk
Clocks (0.021 W 10.001W (=18 T dutigen_dut[9] bram_top_instibram_instfmem_reg_0_0_i_3_n_0 73000 36011 16 16 dk
* Signals (0.182 W) 10.001 W : I dut/gen_dut{1].bram_top_inst/addr_b[16] 73.000 63.934 7 35k
22T (R 10.001 W (=1% of to T dut/gen_dut9].bram_top_insvaddr_b{3] 73.000  36.049 34 34 dk
Clock Enabie (<0.00 10001 W 73000 36019 16 16k
SetReset (<0 10.001W (= 72000 36.000 16 16k
Logic (0.0 10.001 W (=18 73000 63934 a4 a4 dk
BRAN (0.6521) 10.001W 74000 36.001 15 16 dk
Clock Manager (0.117 W
1O (0.005 00.001W (=1% ofto I dut/gen_dut{9] bram_top_inst/addr_b[0] 73.000 63.934 34 34 clk
10,001 W (= total) T dutigen_dutj2] bram_top_instiaddr_b[5] 73000 63936 4 4k
| c— y T T T — S
impl_1(saved) *  power_1 X | power_2 X

Figure 38: Power Report Signals > Data View - Simulation SAIF Data for Signal Rates

7. In the Summary view of the power_1 report (the report generated by the vectorless analysis), click
on Confidence level (High in Figure 39).

The Confidence Level is a measurement of the accuracy and the completeness of the input data that
the Report Power uses while performing power analysis.
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Notice that the Confidence Level is High for the vectorless analysis since less than 25% of internal

nodes are user specified for Internal Activity.

Power ? —0a X
Q X £ C7 summay
Seftings Power analysis from Implemented netlist. Activity On-Chip Power
Summary (1.545 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1.080W  (70%)
~ Utilization Details
Total On-Chip Power: 1.545W .
Hierarchical (1.08 o ER - 21% Clocks: 0.022W
Junction Temperature: 217 °C 70% Signals: 0.223W
Thermal Margin: 57.3°C(30.1W) Logic: 0.000W
Effective 3JA: 1.8 "C/W M BRAN: 0.705W
Power supplied to off-chip devices: 0W W uch: 01T W
Confidence level: Medium o- nOnAWwW (0o
Launch Power Constraint Advisor to find ar Confidence Level Details X
0 0 invalid switching activity
Design State: High
Clock Manager (0.1 Design is routed
IO (0.004 W) Clock Activity: High
| < c— User specified more than 95% ofclocks
impl_1 (saved) X | power_1 X | power_2 X 110 Activity: High
User specified more than 95% of inputs
Internal Activity:
User specified less than 25% of internal
nodes
Characterization Data: High
Device models are Production
Figure 39: Confidence Level for Vectorless Power Analysis (power_1)
In the Summary view of the power_2 report (the report generated by the analysis for which you
specified a SAIF file as input), click on Confidence level (High in Figure 40).
Notice that the Confidence Level has increased to High, since more than 25% of internal nodes are
user specified for Internal Activity.
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Power ? -0 a X
Q X 2 C7 summay
Settings ) . . ;
Power analysis from Implemented netlist. Activity On-Chip Power
Summary (1.485 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic; 1.019W (FO%
~ Utilization Detail
flization Lietalls Total On-Chip Power: 1.485W Clocks: DOAW (2
Hierarchical (1.019 Junction T ; 7.6 18% = melt “
unction Temperature: . ’ . .
Clocks (0,021 P B9% Signals:  0.182W (18°
- . |
~ Signals (0.182 V Thermal Margin: A7.4°C(30.2W) Logic: 0.008 W 1o
Data (0182 W Effective 3JA: 18°CWwW 67% BRAM: 0BEEW (F7%
Clock Enable (= Power supplied to off-chip devices: 0W W mch: OA1TW  (12%
SetiReset (=00 Confidence level: High | qoog ey 0 005 W
Logic (0.008 V! Launch Power Constraint Advisor to find § Confidence Level Details X
BRAM (0 625\ invalid switching activity
! Design State: High
Clock Manager (0.1 Design is routed
0 (0.005 ¥ Clock Activity: High
< > User specified more than 95% of clocks
impl_1 (saved) X | power_1 X | power_2 X 110 Activity: High
User specified more than 95% of inputs
Internal Activity: High
User specified more than 25% of internal
nodes

Characterization Data: High
Device models are Production

Figure 40: Confidence Level for Power Analysis with SAIF Input (power_2)

Generating a SAIF File using Questa Advanced Simulator

The following steps will take you through the process of SAIF file creation, running timing simulation,
and estimating power using the SAIF data using Questa Advanced Simulator.

IMPORTANT: Make sure the Vivado Design Suite knows where to pick up the Questa Advanced
Simulator tool. You can either:
Manually set the path to ModelSim/Questa Advanced Simulator using the $PATH environment

variable
or

From the Tools > Settings > Tool Settings section, define the path to the simulator in the
Vivado IDE under the 3rd Party Tools tab: Questa Advanced Simulator install path.
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Make sure the Compiled library location points to a valid location for the compiled Xilinx

simulation libraries.

To create new compiled libraries:

1. In the 3" Party Simulators tab, specify the Compiled library location to Questa Advanced
Simulator. Use the Compiled library location specified during the compiled library generation and
enter it in the Compiled library location field of 3" Party Simulators tab. It should point to the
compile_simlib directory.

2. Click OK to define the path and generate compiled libraries.

¢ Settings

Project Settings
General
Simulation
Elaboration
Synthesis
Implementation
Bitstream

P

Tool Settings

Project

IP Defaults

Source File

Dizplay

WebTalk

Help

Text Editor

3rd Party Simulators
» Colors

R

Selection Rules
Shortcuts

Sirategies

-

‘Window Behavior

3rd Party Simulators
Specify install paths and default compiled library paths. Default compiled liorary path will be ‘
applied only at new project creation.

Install Paths

ModelSim:

CIEIEIEIEIED BT RG]

Questasim: | GJgensysigensysiquestal0.5ciwin32

IES:
VCS:
Riviera:

ActiveHDL:

Default Compiled Library Paths
ModelSim:
Questa:
IES:
VCS:
Riviera:

ActiveHDL:

w

| Cancel | ‘ Apply | ‘Bestore...

Figure 41: Setting the Questa Advanced Simulator Installation Path and compiled libraries
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Step 1: Configuring and Running Timing Simulation in
Questa Advanced Simulator

Now you are ready to set up and launch the Questa Advanced Simulator to run post-implementation
timing simulation. You will set the timing simulation properties in the Vivado IDE, and run the timing
simulation.

1. In the Flow Navigator, right-click Simulation to select Simulation Settings. Set the timing
simulation properties.

2. In the Simulation Settings tab, set the Target simulator to Questa Advance Simulator.

3. Click Yes to change your target simulator to Questa Advance Simulator.

¢ Target Simulator @

-

o Questa Advanced Simulator requires that Xilinx libraries are pre-compiled.
You can compile Xiling simulation libraries by going to tools menu and clicking
on compile simulation libraries. Make sure that the compiled library location
in simulation setings menu is pointing to the correct file. To confirm
the status ofthe compiled libraries run report_simlib_info Tcl command.

Ok to change your target simulator to "Questa Advanced Simulator?

Figure 42: Simulation Settings — Changing the Target Simulator

4. Set the questa.simulate.saif to power_tutorial_timing_questasim.saif.
5. Set the questa.simulate.saif scope to testbench/dut_fpga.

6. Note that the questa.simulate.runtime is 1000ns.
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Simulation
Project Settings Specify various settings associated to Simulation ‘
General
Simulation Target simulator: Questa Advanced Simulator w
Elaboration ) -
) Simulator language: Mixed L2
Synthesis
Implementation Simulation set: i sim_1 L2
Bitstream ) )
s P Simulation top module name: | testbench E
- ¥ Clean up simulation files
Tool Settings
Project Compiled library location; i.lakashaftmp/Tutorialiread_saifiproject_3/project_3.cache/compile_simlib/questa B
IP Defaults
Source File - _ . - ] :
Compilation Elaboration Simulation Netlist Advanced
Display
| ~
WebTalk questa.simulate.log_all_signals*® o
Hel
P questa.simulate.custom_do
» Text Editor i
questa.simulate.custom_udo
3rd Party Simulators
questa.simulate.custom_wave_do
» Colors
i questa.simulate sdf_delay sdfmax
Selection Rules
uesta.simulate ieee_warnings v
Shortcuts g — g
) . .
Strategies questa.simulate saif_scope testbench/dut_fpga
questa.simulate saif* power_tutorial_timing_questasim|saif

B

Window Behavior
questa.simulate vsim.more_options

questa.simulate.saif*
Specify SAIF file

¢ Settings @

':_'_?‘:' | Cancel | | Apply | | Restaore...

Figure 43: Configuring SAIF file Settings

7. Click OK. With the simulation settings properly configured, you can launch the Questa Advanced
Simulator to perform a timing simulation of the design.

8. In the Flow Navigator, click Run Simulation > Run Post-Implementation Timing Simulation.
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v SIMULATION Net Properties

Fun Simulation

Fun Behavioral Simulation

¥ RTL AMALYS _ _ _ _
Fun Post-Synthesis Functional Simulation

» Open Elz o _ _
Fun Post-Synthesis Timing Simulation
v  SYNTHESIS Fun Post-Implementation Functional Simulation
Run Post-Implementation Timing Simulation
P Run Synt . g

Figure 44: Running Post-Implementation Timing Simulation

A separate Questa Advanced Simulator GUI opens and starts simulating the design.

9. After the Questa Advanced Simulator has finished simulating the design, make sure the SAIF file
requested has been generated. Check to see that the SAIF file requested in the simulation settings
prior to running simulation appears in this directory:

<project_directory>/power_tutoriall/power_tutoriall.sim/
sim_1/impl/timing/power_tutorial_timing_guestasim.saif

Step 2: Running Report Power in Vectorless Mode

IMPORTANT: If SAIF based report_power has already been run in this session, run the
reset_switching_activity -all command in the Tcl Console. This will clear the SAIF
data in the power engine from the earlier runs.

1. Close any open Report Power views.

2. In the Flow Navigator, select Implemented Design > Report Power to open the Report Power
dialog box.

Alternatively, select Reports > Report Power in the main menu bar.
3. In the Report Power dialog box, make the following settings:
0 Specify the Results name as power_1
0 In the Environment tab, Set the Process to maximum
0 In the Switching tab, leave the Simulation activity file empty

4. Verify that all the input settings are correct and click OK.
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The Report Power command creates a Power Report under the power_1 tab in the results windows
area. Note that the total power for Vectorless Analysis runs with default switching rates.

Power ? -0 a X
Q = = ' Summary
Settings onChi
Power analysis from Implemented netlist. Activity n-Chip Power
gummary (1.435 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1.019W  (69%)
~ Utilization Details
Total On-Chip Power: 1.485W .
Hierarchical (1.012 P 18% Clocks:  0.021W
Clocks (0.021 W) Junction Temperature: 27.6 °C £9% Signals: 0.182 W
~ Signals (0182 W) Thermal Margin: 5r4°C(30.2w) Logic: 0.008 W
Data (0.182 W) Effective 3JA: 1.8 "CIW M EReM: 0.685 W
Clock Enable (- Power supplied to off-chip devices: 0W B uvcH: 01T W ]
Set/Reset (=0.0 Confidence level: High 110: 0.005W  (0%)
Logic (0.005 W) Launch Power Constraint Advisor to find and fix ks
BRAM (0.685 W) invalid switching activity Device Static: 0ABEW  (31%)
Clock Manager (0.1
1/C (0.005 W)
| I . 2 rrrrrrrrrr————————————————————————————————————————————————
impl_1 (saved) X | power_1 X

Figure 45: Power Report — Vectorless Mode Run
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Step 3: Running Report Power with Questa Advanced
Simulator SAIF Data

The SAIF output file requested in the simulation run has been generated under the project directory.
We use this SAIF file — a "Switching Activity Interchange Format” file — to further guide the power
estimation algorithm.

1. In the main menu bar, select Reports > Report Power.
2. In the Report Power dialog box, specify the SAIF file location in the Switching tab.

The SAIF file, which was requested in the simulation settings prior to running simulation, should
appear here:
<project_directory>/power_tutoriall/power_tutoriall.sim/
sim_1/impl/timing/power_tutorial_timing_guestasim.saif
3. Click OK in the Report Power dialog box.

The Report Power command runs, and the Power Report power_2 is generated in the Power tab of
the results windows area.

Power ? —-0a X
Q = & C ? summary
Settings On-Chip P
Power analysis from Implemented netlist. Activity n-Lhip Power
pummary (1.485W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1.019W  (69%)
~ Utilization Details Total On-Chip P 1.485 W
otal On-Chip Power: . . 2%)
Hierarchical (1.019 W) n 18% Clocks:  0.021W  (2%)
Clocks (0,021 W) Junction Temperature: 276°C G3% Signals: 0.182W  (18%)
« Signals ( Thermal Margin: 57.4°C(30.2W) Logic: 0.008 W
Data (0,182 W) Effective SJA 18w M BRAM:  0685W (67%)
Clock Enable (=0.00 Power supplied to off-chip devices: 0W M mmcH: O1ITW  (12%)
SetReset (0W) Confidence level High 1io: 0.005W (0%
Logic (0.008 W) Launch Power Constraint Advisor to find and fix k2
BRAM (0.685 W) invalid switching activity Device Static: ~ 0.486W  (31%)

Clock Manager (0,117 V!
10 (0.005 W

power_2 X  power_1 X

Figure 46: Power Report — With SAIF File Data

4. In the Tcl console, observe the read_saif results. This shows the percentage of design nets matched
with simulation SAIF. This is important for accurate power analysis.

5. Go to the Signals > Data view in the Power Report and scroll to the right. Note that all the Signal
Rate data has been set from simulation SAIF data you provided.
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The data is color coded to indicate activity rates read from the Simulation output file.

Power ? _0a X
Q T & C 7 QO T Data Simulation Calculated
Setings Utilization Name signal Rate (Mtr's) % High  Fanout  Slice Fanout €
summary (1.455 W) ~ EEO0.182W (12% oftotal) (] dut_fpga -
Power Supply 10.001W (= T dut/gen_dut[9].bram_top_instiaddr_a[1] 73.000 63.935 34 34 ¢
~ Utilization Details 10.001W (=1% I dutigen_dut{9] bram_top_instiaddr_b[11] 72000 36.049 a4 U
Hierarchical (1.019 W) 10.001 W (<1% T dutigen_dut[1].bram_top_instbram_instmem_reg_2_0_i 2 n 0 74000  36.001 16 16 ¢
Clocks (0.02 10.001W (= T dut/gen_dut/9).bram_top_instibram_instmem_reg_0_0_i_3_n_0 73000 36.0M 16 16 ¢
* Signals (01821 10.001 W (=15 T dutigen_dut[1].bram_top_instiaddr_b[16] 73.000 63.034 a7 B ¢
ZEE (TG 10.001W T dutigen_dut[9].bram_top_instaddr_b[3] 73.000  36.049 34 Mo
Clock Enable 10.001W (= I dut/gen_dut[9]. bram_top_instlbram_instmem_regq _0_0_i 4_n_0 73.000 36.019 16 16
Logiscetfﬁsise_t_f:_l. I0.001W I dutigen_dut[8].bram_top_instbram_instmem_regq_2_0_i_1_n_0 T72.000 36.000 16 16 ¢
BRAN 10.001W (=1% I dutigen_dut[2]. bram_top_instiaddr_b[0] 73.000 63.934 34 34
Clock Manager (0.117 1 1 0.001W (= I dutigen_dut[9].bram_top_instlbram_instmem_regq_2_0_i 2_n_0 74000  36.001 16 16
10 (0.005 W) 10.001W(=1% I dut’gen_dut[9] bram_top_instiaddr_b[0] 73000 63934 34 34 c
10.001W (<19 T dutigen_dut[2] bram_top_inst/addr_b[5] 73.000 63.936 k71 M
10.001W (= T dutigen_dut[9] bram_top_instibram_instmem_reg_2_0_i_1_n_0 72.000  36.000 16 6
10.001W (=19 T dutigen_dut[9] bram_top_instiaddr_b[16] 73.000 63934 a7 ®/
10.001W (= T dutigen_dut[8].bram_top_instibram_instmem_reg_0_0_i 4_n 0 73.000 36.019 16 6
10.001W (=1% T dutigen_dut[2] bram_top_inst/addr_b[1] 73.000 63.936 a4 M4 c,
¢ » < 3
power_2 x power_1 pS

Figure 47: Signals > Data View with SAIF File Data

6. Note the change in total power (Total On-Chip Power in the Summary view) in the power_2
report compared to the power_1 report. The total power estimated in the report generated with
SAIF file data will be different than the total power estimated in the vectorless run (power_1 results).

Conclusion

In Lab 2, you have learned how to generate a SAIF file after running a timing level simulation using a
Vivado Simulator and Questa Advanced Simulator.

In Lab 3, you will learn about basic hardware power measurement technique using the KC705
Evaluation Board and correlating the hardware power numbers with the numbers generated by Vivado
Report Power.
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Lab 3: Measuring Hardware Power Using the
KC705 Evaluation Board

Introduction

In this lab, you will learn about basic hardware power measurement technique and correlating the
hardware power numbers with the numbers generated by Vivado® Report Power using KC705
evaluation board for 7 series devices. The lab will take you through the steps for setting up the
hardware measurement, programing a bit file using Vivado Hardware Manager and power
measurement through Texas Instruments (TI) Fusion Design Software. It also includes Junction
Temperature reading from Vivado System Monitor.

Step 1: Generating a Bit File from the Implemented Design
(Non-Power Optimization)

1. In the Vivado Design Suite, open the 7 series Implemented design.
2. In the Flow Navigator, click Generate Bitstream.

The Bitstream Generation Completed dialog box appears after the bitstream has been generated.

Bitstream Generation Completed @

o Bitstream Generation successfully completed.

Next
View Reports
@ Open Hardware Manager

Generate Memory Configuration File

Dont show this dialog again

Figure 48: Bitstream Generation Completed Dialog Box
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Evaluation Board

3. Open the Hardware Manager by selecting Open Hardware Manager in the Bitstream Generation
Completed dialog box and clicking OK.

Step 2: Setting Up the KC705 Evaluation Board

IMPORTANT: This project is created for the KC705 Rev 1.0 Evaluation Board. The pin constraints
are set based on this Evaluation Board. If you are using any other Revisions, update the XDC file
dut_fpga_kc705.xdc with the correct pin constraints.

1. Connect the Digilent Cable (or Platform USB Cable) for Programming.
2. Connect the TI USB Interface Adapter to the PMBus port on the KC705 Evaluation Board.

3. Connect the Power Cable.

© O ®

¥ LSt "
paju 480N

X14505

Figure 49: KC705 Hardware Setup
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Evaluation Board

4.

Lab 3: Measuring Hardware Power Using the KC705

www.ti.com/tool/fusion_digital_power_designer

Install the Tl Fusion Digital Power Designer software on the PC from this location:

Step 3: Setting Up the Fusion Digital Power Designer

Software
1.

Power ON the KC705 Evaluation Board.

2. Open the Fusion Digital Power Designer.

The software detects the USB adapter and brings up the GUI.

Fusion Digital Power Designer - UCD9248 @ Address 52d - Rail #1 - Texas Instruments

File Device Tools Help UCD3248 @ Address 52d - Rail #1
Configure vout Config | Tout,Vin, Temp Canfig || Other Config || Phase/Rai Config |[ GPIO Config |
Sequence On and Off Timing | [ucp9248 @ 52d - Rail #1
350 i i imi
Auto write on rail or Rail #3 [~ Voltage Setpoint, Margins, and Limits
device change 3.00 4 Vout Max: 1.600 v
2.50 Rail #4; Rail #1
2 2.00 - 5
= Over Fault: 1.150 v 15.0 5 % OV Response
Store RAM To Flash ] 3 1509 Qver Warn: 1100 v 0.0 %
1.00 -
RestnreF\ashtnﬁAM] 0.50 \ Margin High: 1050 Hv 5.0 %
0.00 Vout: 1.000 v
[ 2 4 8 10 12 14 16 18 20 2 24 26 28 =
i Margin Low: 0.950 = v 5.0 % Synchronize
- Time (msec) E E marginslimits/
Copy Rail/Design ] Under Wiarn: 0.900 E v -10.0 E % PG to Vout
Plot: Select Rail to Edit Review in Larger Window () Under Fault: oss0 v | -1s0f% UY Respanse
O Soft Start Ral # Vout |PGOn | PGOFf |OnDelay |Rise |OffDelay |Fall |Dependen A | over curentiv: [ 0sm v | 13.05% OCLY Response
() Soft Stop 1
(%) Both
© 8o UCD9248 @ 52d 2 1.800 1620 1.530 0.0 5.0 5.0 1.0 vIN_ON @6.000 V, VIN_OFF Power Good On: 0.800 E v -10.0 E %o
Show raillabels UCD9248 @ 52d 3 3300 2970 23805 00 50 40 L0 VIN.ON@6.000V, VIN.OFF | Power Good O | pesoEv | 150 %
O 5h|0w current device UCD9248 @ 52d 4 2.500 1.700 1.650 0.0 5.0 3.0 1.0 VIN_ON @ 6.000V, VIN_OFF |
only
UCD9248 @ 53d 1 2500 2250 2125 00 50 10 L0 VIN_ON @6.000V, VIN_OFF OnfOff Config: 0x00 (Always Converting)
UCD9248 @ 53d 2 1500 1350 L1275 00 50 0.0 10 VIN_ON @8.000V, VIN_OFF e ToETT
UCD9248 @ 53d 3 1000 0.900  0.850 00 50 7.0 1.0 VIN_ON @6.000 V, VIN_OFf — Tum On Delay: 0.0[F] ms | | Tum Off Delay: 10.0[F] ms
UCD9248 @ 53d 4 1200 1080 1020 00 50 8.0 1.0 VIN_ON @6.000V, VIN_OFF
ucD92e8 @ 54d 1 2000 1800 1700 00 50 20 L0 VIN_ON @ 6.000 V, VIN_OFF v SSpEe 5.0 (ms || Fal Tme: 105 ms
i —
Tips & Hints PMBUs Log (=]
. Design —
TOFF_MAX_WARN_LIMIT [0x66,Rail #1]
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L status output voltage to decay.
) security | PMBus Log | &
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Step 4: Programming the Bitstream
1. Power up the KC705 Evaluation Board.
2. Inthe Vivado Hardware Manager, click Open Target in the green alert bar and select Open New
Target.
HARDWARE MANAGER - unconnected
0 Mo hardware target is open. Cpen target

£’ Auto Connect
Hardware

Cpen Mew Target..

Mo content

Figure 51: Opening the New Hardware Target

3. In the Open New Hardware Target dialog box, click Next to go to the Hardware Server Settings.
4. Select the server to which the board is connected.
o If the board is connected to the local PC, select Local Server and click Next.

o If you are connecting to a remote server, see Connecting to a Hardware Target Using
hw_server in the Vivado Design Suite User Guide: Programming and Debugging (UG908).

When the hardware is detected successfully, the part information will be displayed in the Open New
Hardware Target dialog box.
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5. Verify the part information, then click Next and Finish.

¢ Open New Hardware Target @

Select Hardware Target

Select a hardware target from the list of available targets, then setthe appropriate JTAG clock (TCK) frequency. If you do not see the ‘
expected devices, decrease the frequency or select a different target.

Hardware Targets
Type Mame JTAG Clock Frequency
@ xilink_tcf  Digilent210203337377A4 15000000 ~

Add Xilinx Virtual Cable (XVC)

Hardware Devices (for unknown devices, specify the Instruction Register (IR} length)

Mame ID Code IR Length
& xc7k3251_0 33651093 6

Hardware semver: localhost 3121

Cancel

Figure 52: Hardware Target Detected

6. In the Hardware window, right-click the part and select Program Device.
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HARDWARE MANAGER - localhostixiling_tcfiDigilent210203337377A

€ There are no debug cores. Program device Refresh device

Hardware ? 00 X
Q = = o
MName Status
~ B localhost (1) Connected
~ @l xiline_tcfDigilent’2102033373..  Open
~ {8 xcTK325t_0 (1) Pranrammand
& XADC (System Monitor) Hardware Device Properties...

Program Device. ..
Verify Device...

(™ Refresh Device

Add Configuration Memary Device...

Boot from Configuration Memaory Device

FProgram BBR Key...

Hardware Device Properties ? _ Clear BBR Key...
{8 xcT7K3Z5t_0 Program eFUSE Registers..
Exportto S dsheet...
Name: XCTK325t_0 rportio spreadsnee
Part: ¥C/k325t
ID code: 33651093
IR length: G
Status: Programmed

Programming file: | ect_<1/project_1.runsfimpl_1/dut_fpc

Probes file:

User chain count: 4
< >

General Properties

Figure 53: Program Device

7. Select the bit file <project_dir>/power_tutoriall/power_tutoriall.runs/impl_1/
dut_fpga.bit and click Program.

8. After the program completes successfully, select XADC (System Monitor) in the Hardware window,
then right-click and select Dashboard, and then select New Dashboard.

9. Click OK. The System Monitor window opens and plots Die Temperature (Junction Temperature) in
the Graph Window.
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| MANAGER - Jocalt [=? 3ITITTA
10 There are nio debug cores. Program device Rafreah o
Hardware dushboard_1
Q = o RADC [xc7KI250_0)
Harne Stabus é
. 1] et
b Connactad £
- r Dpen S [ ETem
Programmed | 5 |HIVEES
&
[
System Monitor Core Proparies g
@ xDG - o 83
"

ocalmost 321 dline_tetDigilentZ102003373774

181830

Tims (HHUMSS]

Genaral

Figure 54: System Monitor — Junction Temperature Plot

Step 5: Measuring the Hardware Power Rails

1. In the Fusion Digital Power Designer, select a rail in the Configure view and click Monitor.

LCDAZE § Address 53 -Rad 81

File Decce  Tock  Help
Configure vout Config | lout,vin, Temp Condg || Other Conflg || Phase/Ral Conflg || GPID Config
Sequence On and O Tising 7| [ueDe24R @ 534 - Rail 81
uste waite o rad o 350 - T — Voltage Setpost, Margins, and Limits
device change 3004 600
250
Z 200 ¥ 150 % BN Rorsgorne [
Siore RAM To Flash 3 osiet] 0.0
1.00 -
Testare Flashte RAM 850 L0%0
000 BB~ R N S | ALl ' L 2 B N 2000
o 2 4 6 8 10 12 14 1% 18 0 2 M % W

Time (msec)

50 [
— Turn On T —
Tl On belay: oofms |0 0.0[5] ms
Rise Tme: 5.0[ 5 ms | | FaT Tims
- Ties &z v
Dason TON_DELAY [0e60,Rad #1]
Skts the m when & start condibon i recenved (88 programmed by the
ON_DFF 2] LA the DU voitnge SEAFTS I rise
Status
Security 5 || pes Log "2}~ ]
AP Trwas esmmsarnrs | heson digital power

Futson Digital Power Designes v 8325 [2013-05-07) | UCD9248 Furnwware v5.8.0.11400 © Address 52d | USE Adapter v1.0.14 [PEC: 400 kHz]

Figure 55: Select a Rail to Monitor

2. Configure the parameters to be monitored. An Output Power graph will be plotted in the Monitor

window.
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|[ File Device Tools Help UCDS248 @ Address 52d - Ral #1 =

= = Y
Monitor Y| (Readings - Rail #1 1~ ¥ Pout - Output Power | &
Show/Hide Plots: Vin: 12.000 V 1.60
O vin Ctn Tn: NjA A
; I a8 e o vyt - -
[CJpin [ vtrack Pin: WA W -y
[ vout [Ivoutta) ||| | virack: —y 1.2
Tout Tout(all
g Loutten fl | 1005 v
Pout ] Ext Tem 1.
Int Temp [_] All Temp (=3 LW e
Doty Duty Cycle:  10.30 %
Fan Speed: RPM e
(%) Fit All Plots on Screen P — .
() Scale Plots to Screen Phase #1 1.38 A 519
Viidth 5
[Lines 1 000
#1: o920 09:40 10:00 10:20 10:40
Show Warn & Fauit MLt =
Limit Editors Tout #1: 0K T
Show Value Labels Temp #1: oK UCD9248 Internal Temperature | 5}
on Flots Input #1: OK S ——r
o o e N S 3
Poling Rate:| 500 Misc: oK . SORE
=) Logged Fit £1: FLT
R oK -
| swproling | || |sMpAlERT# Mot Asserted
[ reilDashboard | | clearLogged Fauts |
15
{) Configure Control Line (USB) b
— — 10
@ High OLow
%) Design (2) Hig O
§ 8 5
) Monitor Operation - Rail #1
09:20 09140 10:00 10:20 10:20
.. Status E
4 Security 4PMBus Log Messages Show PMBus Lo Unique open/dose settings for Configure, Design, Monitor, Status, and Security 7] ‘
Fusion Digital Power Designer v1.8.325 [2013-05-07] | UCD9248 Firmware v5.8.0.11400 @ Address 52d | USB Adapter v1.0.14 [PEC; 400 kHz] 43 Texas Instromens | fusion digital power

Figure 56: Monitor a Rail - Power and Junction Temperature

3. Repeat the steps above to monitor the power information for each rail supplied to the device. Note
that rail information is displayed in terms of Regulator address.

KC705 -(UcD9248)
device rail purpose voltage [OUT CAL GAIN 10UT CAL OFFSET

1 VCCINT 1.0V OxEBDC Ox8000
52 2 VCCAUX 1.8V O0=xEBDC 0x&000
S VCC3V3 3.3V OxEBDC 0x8000
4 VADJ 2.5V OxEBDC Ox8000
N VCC2VS 2.5V OxEBDC Ox2000
a2 2 VCClvs 1.5V OxEBDC Ox8000
3 MGT_AVCC 1.0v OxEBDC 0x8000
4 MGT_AVTT 1.2v OxEBDC Ox8000
1  VCCAUX 10 1.8V OxEBDC 0x8000
- 2 VCCBRAM 1.0v OxEBDC Dx8000
3 MGT_VCCAUX 1.8V OxEBDC Ox&000
4  N/A N/A N/A N/A

Figure 57: KC705 Rail Address Mapping

4. Note the Junction Temperature value either from the Vivado Hardware Manager or from the Fusion
Digital Power Designer.
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Step 6: Estimating Vectorless Power with Junction
Temperature

For further Power Analysis, you can use the measured Junction Temperature and other thermal settings
to feed into Vivado Report Power for better accuracy.

1. In the Vivado Design Suite, open the tutorial project and click Open Implemented Design to
display the implemented design.

2. Inthe Tcl Console, run the following command to reset any user defined or SAIF file defined
settings.

reset_switching_activity -all
3. In the main menu bar, select Reports > Report Power.

4. In the Report Power dialog box Environment tab, enter the Junction Temperature value supplied
by the hardware power measurement.

5. Set the Process to maximum.
6. In the Switching tab, make sure the Simulation activity file (saif) is blank.

7. Click OK.
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¢ Report Power

Estimate power consumption based on the netlist design and parn xcku040-fva1156-2-2.

el

Results name: |pnwer_1

Environment

Device Settings
Temp grade:

Process:

Environment Settings

Cutput Load:

< Junction temperature:

Ambient temperature:
Effective SJA:

Airflow:

Heat sink;

LS

Board selection:

Mumber of board layers:

2JB:

Board temperature:

Legend

User Defined

Power Supply

Switching

Maximurm

250

medium |

Qutput
At
02 pF [0-
M T o
C
142 *C/Ww [0
w LFM
medium (Medium Prof.. s
"CaW [0
107107 L
12t015 (12 to 15 Layer... w
G [0 -
*C

Calculated

Default

- 100]

- 100]

100]

n
o

- 100]

Cancel

-

Figure 58: Report Power Settings — Updating Junction Temperature
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8. In the Power Report, observe that the power numbers increase slightly as compared to the
vectorless power analysis using a default Junction Temperature value. Note that the Junction
Temperature is now color coded as being user defined in the Power Report.

Power ? -0 aXx
Qg = = ' Summary
Settings .
g Power analysis from Implemented netlist. Activity On-Chip Power
Summary (1.576 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 107W  (65%)
~ Utilization Details
Total On-Chip Power: 1576 W Clocks: 0.024 W
Hierarchical (1.017 Junction T ture: 340°C — 23% ’ ' )
Clocks (0.024 W) unction 9"‘?‘*”‘ ure: : Signals:  0.232W
+ Signals (0.232 W) Thermal Margin: 51.0°C (26.7 W) Logic: 0.016 W
Data (0232 W Effective 3J4& 1.8 °CWw B BRAM: 0624 W
Clack Enable | Power supplied to off-chip devices: 0W B ch: 01T W
SetReset (0 V) Confidence level: Medium o 0.004W
) 35% o )
Logic (L Launch Power Constraint Advisor to find and fix
BRAN (0,524 W) invalid switching activity Device Static. ~ 0.558 W  (35%)
Clock Manager (0.
WO (0.004 W)
| G 2
power_1

Figure 59: Power Report — Vectorless Analysis with Junction Temperature Supplied

9. Similarly, you can overwrite the Junction Temperature setting and do a SAIF based power analysis.

Note the power numbers measured and estimated on non-power Optimized design.

Conclusion

In this lab, you have completed a Vivado Report Power analysis on post-synthesis and post-
implementation netlist designs without Power Optimization. You also experimented with hardware
power measurement using the KC705 Evaluation Board and with reading Junction Temperature for
software analysis.

In lab 4, you will learn to experiment with hardware power measurement using the KCU105
Evaluation Board and with reading Junction Temperature for software analysis.
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Lab 4: Measuring Hardware Power Using the KCU105
Evaluation Board

Introduction

In this lab, you will learn about the basic hardware power measurement technique and correlating the
hardware power numbers with the numbers generated by Vivado® Report Power using the KCU105
evaluation board for UltraScale™ devices. The lab will take you through the steps for setting up the
hardware measurement, programing a bit file using the Vivado Hardware Manager and power
measurement through the Maxim Digital Power Tool. It also includes the Junction Temperature reading
from the Vivado System Monitor.

Step 1: Generating a Bit File from the Implemented Design

1. In the Vivado Design Suite, open the UltraScale Implemented design.
2. In the Flow Navigator, click Generate Bitstream.
3. When prompted to Save project before generating bitstream, click Don’t Save.

The Bitstream Generation Completed dialog box appears after the bitstream has been generated.

I =

Bitstrearn Generation Cormpleted @

I:o:l Bitstream Generation successfully completed,

Mext

View Reports

@ Dpen Hardware Manager

Generate Memory Configuration File

Don't show this dialog again

QK | | Cancel

Figure 60: BitStream Generation Dialog Box
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4. Select Open Hardware Manager in the Bitstream Generation Dialog box and click OK to open
the Hardware Manager.

Step 2: Setting up the KCU105 Evaluation Board

IMPORTANT: This project is created for the KCU105 Rev B Evaluation Board. The pin constraints
are set based on this Evaluation Board. If you are using any other Revisions, update the XDC file
dut_fpga_kcul05.xdc with the correct pin constraints.

1. Connect the Digilent Cable (or Platform USB Cable) for Programming.

2. Connect the MAXPOWERTOOL002# Interface Adapter to the PMBus port on the KCU105 Evaluation
Board.

3. Connect the Power Cable.

KIB3:0 032415

Figure 61: KCU105 Hardware Setup

Power Analysis and Optimization www.xilinx.com 65
UG997 (v2018.3) December 5, 2018 send Feedback


http://www.xilinx.com/
https://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG997&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Power%20Analysis%20and%20Optimization&releaseVersion=2018.3&docPage=65

v
iA XI LI NX Lab 4: Measuring Hardware Power Using the KCU105

Evaluation Board

4. Install the Maxim Digital Power Designer software on the PC from this location.

https://www.maximintegrated.com/en/design/tools/applications/evkit-software/index.mvp?id=1183

Step 3: Configuring the Maxim Digital Power Tool Software
1. Power ON the KCU105 Evaluation board.

2. Open the Maxim Digital Power Tool. The software detects the Interface adapter and brings up the
GUL.

[ Dashboard { Ox0A | 0x08 | OxOF [ Ox11 | Ox12 | Ox14 | 0x15 [ 0x16 [ ox18 [ 0x1B
MAX15301 MAX15303A400 | MAX15303AA00 | MAX15303AA00 | MAX15301 MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15301

Product ~ MAX15301  MAX15303AA00 MAX15303AA00 MAX15303AA00  MAX15301  MAX15303AA00 MAX15303AA00 MAX15303AA00 MAX15303AA00  MAX15301 _82‘}’2.,."'&"1‘31‘ =]
— Ox18:MAX15303 ——

Use Hardware Enable
Input Voltage (V) 11422
Qutput Current (A)

1360
Internal Temperature (°C}

Vout (V)
B

Clearfaults [ Clear || Clear  |[ clear |[ Clear || Clear |[ Clear |[_ Cear |[_ Clear |[  Clear [ Clear | v
0850 1.800 0450 1,800 1,800 1.200 1,000 1.200 1800 2| EE = T
On Delay Time (ms) 498 EIEI 11.80 EIEI 7.82 EIEI 19.75 EIEI 2484 EIIZI 2488 EIIZI 10,09 EIIZI 1522 EIIZI 1975 EIIZI 100 EIIZI o
202 232 177 232 235 188 183 188 232 2 213 & *s © ® e
Off Delay Time (ms) 2497 1477 1988 [ 796 5 511 5115 1988 [H 178 [H 1023 [ 3008 Start Up
202 232 177 232 235 188 183 188 232 2 213 B3l C e For Deviees) [save Configurat

Figure 62: Maxim Digital Power Tool

Step 4: Programming the Bitstream

1. In the Vivado Hardware Manager, click Open Target in the green alert bar and select Open New
Target.

2. In the Open New Hardware Target dialog box, click Next to go to the Hardware Server Settings.
3. Select the server to which the board is connected.
o If the board is connected to the local PC, select Local Server and click Next.

o If you are connecting to a remote server, see Connecting to a Hardware Target Using
hw_server in the Vivado Design Suite User Guide: Programming and Debugging (UG908).
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When the hardware is detected successfully, the part information will be displayed in the Open

New Hardware Target dialog box.

4. Verify the part information, then click Next and Finish.

¢ Open New Hardware Target

Select Hardware Target
Select a hardware target from the list of available targets, then setthe appropriate JTAG clock (TCK) frequency. If you do not see the ‘

expected devices, decrease the frequency or select a different target.

Hardware Targets
JTAG Clock Frequency

Type Mame
W

M xilinx_tcf  Digilent/210251845034 15000000

Add Xilinx Virtual Cable (XVC)

Hardware Devices (for unknown devices, specify the Instruction Register (IR) length)

Mame ID Code IR Length
8 xcku040_0 13822092 6

Hardware server: localhost3121

Cancel

Figure 63: Detecting the Hardware Target

5. In the Hardware Devices window, right-click the part and select Program Device.
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HARDWARE MANAGER - localhostixiling_tcfDigilentfi210251845034

o There are no debug cores. Program device Refresh device

Q =

MName

i

~ B localhost (1)
~ @ xling_tciDigilent2102518450..
~ {8 xcku040_0 (1)

& SysMon (System Monil

Hardware Device Properties

8 xcku040_0
MName: ¥cku040_0
Part: ¥cku040
1D code: 13822093
IR length: B
Status: Mot programmed

FProgramming file:

Frobes file:

User chain count: 4

General Properties

Hardware ?

N i 4
e

Status
Connected
Open

Klnt rronramm

Hardware Device Properties...

Program Device...
Werify Device...

Refresh Device

Add Configuration Memaory Device...

Boot from Configuration Memaory Device

Program BER Key...
Clear BER Key...

Program eFUSE Registers...

Exportto Spreadsheet...

Tcl Console ¥ Messages Serial VO Links Serial 'O Scans

Figure 64: Program Device setup

Lab 4: Measuring Hardware Power Using the KCU105

6. Select the bit file from the implementation runs directory of the project which is created in Lab 2 for
UltraScale design <project_dir>/power_tutorial2/power_tutorial2.runs/impl_1/ dut_fpga.bit and click

Program.

7. After the program completes successfully, select XADC (System Monitor) in the Hardware window,
then right-click and select Dashboard, and then select New Dashboard.
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HARDWARE MANAGER - localhostiiling_tcfiDigilent’210251845034

€ There are no debug cores. Program device Refresh device

Hardware
Q = =

Mame
~ H localhost (1)

~ {8 xcku040_0 (1)
S SysMon (System M

~ @@ xiliny_tcfiDigilent’2102518450...  Open

? 00 X
e |

Status
Connected

Mot programim

dashboard_2

SysMon (xcku040_0)
+ -
B Temp 31.2°C

shboard Options

System Monitor Core Properties...

JTAG Scan Rate

Dashboard

Export to Spreadsheet...

T T

System Monitor Core Properties

& SysMon

Mame: Syshan

? 008 X
- &

Handle: localhost 312 14iling_tcfDigilent2102518450345

b
» = MNewDashboard...

dashboard_2

Figure 65: Creating a New Dashboard

8. Click OK. The System Monitor window opens and plots Die Temperature (Junction Temperature) in

the Graph Window.
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Temperature (°C)

10:10:45 10:11:00

10:11:15 10:11:30
Time (HH:MM:55)

Figure 66: System Monitor- Junction Temperature Plot for UltraScale Device
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Step 5: Measuring the Hardware Power Rails

1. In the Maxim Digital Power GUI, select a rail to monitor the power information.

@ Maxim PowerTool™ (1.09.05) = |[& ][ =
Dashboard | ox0A | 0x0B | oxoF T ox11 | ox12 | ox14 | 0x15 | ox16 | ox18 | ox1B |
MAX15301 MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15301 MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15301

[Configuration | Monitor | Faults Set | PMBus Command | Permissions | Toals |

ot BRIl ——————

Vout Margin High (V) 0.998 % Input Voltage (V) 11875
p— e 2] [ e 38
Switching Frequency Set Point (kHz) 400 = Switching Frequency (kHz) 100
Power Good On (V) 0852 % External Temperature (°C) 42
ae——r oo | | G
| Serup/Shudom Times s ©
On DeayTime ) | 2 5] Qe Coibration )
On Rise Time {ms) 202 EXT_TEMP_CAL-m 10039 ]
Off Delay Time {ms) 2497 =] EXT_TEMP_CAL-b 0.00
Off Fall Time {ms) 202 E
— IOUT_CAL_GAIN (mD) 0550 2
10UT_CAL OFFSET (&) 1109
© Margin High, Ignore Faults (©) Margin High, Act on Faults
© toma  Advanced Coniguraton
© Margin Low, Ignore Faults © Margin Low, Act on Faults
@ Soft Stop © Tristate Stop Advanced Configuration
Save Configuration to File Load Configuration File to Device
| StoreUserAll ][ RestoreUser All | Restore Maxim All ][ Restore Default All

Figure 67: Selecting a Rail to Monitor

2. In Configuration tab, you can observe the basic settings and device status.

3. Click Monitor tab to observe the voltage and current plots.
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Maxim PowerTool™ (1.09.05) = e
Dashboard 0x0A ] 0x0B 0x0F 0x11 12 Ox14 0x15 0x16 0x18 1B
MAX15301 MAX15303AA00 | MAX15303AA00 | MAX15303A400 | MAX15301 MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15303AA00 | MAX15301
Configuration | Monitor ( Faults Set | PMBus Command | Permissions | Tocls
Parameters Device at address: 0x0A
- Configuration Vout (V): Min: 0.950 Max: 0.950 Avg: 0.950 VIN (V): Min: 11.875 Max: 11.875 Avg: 11.875
Cn/Off Canfig 0x16 — vour_____ - VOUT FAULT LIMIT [—win - VIN FAULT LIMIT
20
16
Vout Cammand (V) 0.950 I N N e
Vout Max (V) 1045 e 12
10
Tout Cal Gain 055 N SO SRR DU SO 2
1I—_ § 3
T °
0.5 T el
Tnput Voltage (V) 11.875
2
Output Voltage (V) 0950 0.0 0
300 510 920 530 340 830 300 310 520 530
Qutput Current (A) 3.20 sample sample
g ey (£ 0l lout (A): Min: 3.203 Max: 3.344 Avg: 3.262
Internal Temperature (°C) 48 — oo - TOUT FAULT LIMIT
External Temperature (*C) 43 ~ 120
T T T TP Ry Q e
Duty Cycle (%) 7.53 g 10
= 30 ®
z 5 80
2
G £ £
60
Fault ‘Warning 22 E
E
Vout Under Voltage o] " g
lout Over Current () (@) Ex
0 0
Vin Over Voltage @ o 500 310 520 330 940 830 300 310 20 330
Vin Under Voltage () (w) Sample Sample
VoutOverVoltage o] Stop Plotiing

Figure 68: Monitoring a Rail - Voltage and Current

4. Repeat the steps mentioned above to monitor the power information for each rail supplied to the
device.

Note that the rail information is displayed in terms of Regulator address.

RAIL VOLTAGE PMBUS ADDR
VCCINT 0.95Vv O0x0A
VCCAUX 1.8V 0x0B
VCCBRAM 0.95Vv OxOF
VCC1V8 1.8V Ox11
VADJ_1V8 1.8V 0x12
VCC1V2 1.2V 0x14
MGTAVCC 1V 0x15
MGTAVTT 1.2V 0x16
MGTAVCCAUX 1.8V 0x18
UTIL_3V3 3.3V 0x1B

5. Note the Junction Temperature value from the Vivado Hardware Manager (System Monitor).
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Step 6: Estimating the Vectorless Power with Junction
Temperature

For further Power Analysis, you can use the measured Junction Temperature and other thermal settings
to feed into Vivado Report Power for better accuracy.

6.

In the Vivado Design Suite, open the tutorial project and click Open Implemented Design to
display the implemented design.

In the Tcl Console, run the following command to reset any user defined or SAIF file defined
settings.

reset_switching_activity -all
In the main menu bar, select Reports > Report Power.

In the Environment tab of Report Power dialog box, enter the Junction Temperature value
supplied by the hardware power measurement.

10. Set the Process to maximum.

11. In the Switching tab, make sure that the Simulation activity file (saif) is blank.
12. Click OK.
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Evaluation Board

Lab 4: Measuring Hardware Power Using the KCU105

¢ Report Power

Estimate power consumption based on the netlist design and part xcku040-ffva1156-2-e.

Ex8

Results name: |power_1

Environment Power Supply Switching

Device Settings

Temp grade:

Output

Process:

( maximum

>

Environment Settings

Cutput Load:

< | Junction temperature: (

Ambient temperature:
Effective 314

Airflow:

Heat sink:

S5

Board selection:

Mumber of board layers:

418

Board temperature:;

Legend

Lser Defined

Calculated

0 5| pF  [0-10000
343‘6
*C
1.42 °CAY [0-100]
250 | LFM
medium (Medium Prof.. «
*CA [0-100]
medium (10%10%) w
12to15 (12 to 15 Layer... »
"CAV [0-100]
C 55 -100]

Default

Cancel

.

Figure 69: Reporting Power Settings — Updating Junction Temperature
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13. In the Power Report, observe that the power numbers increase slightly as compared to the
vectorless power analysis using a default Junction Temperature value.

Note that the Junction Temperature is now color coded as being user defined in the Power
Report.

Power ?7 _0aX
- -~ »
Q x & C Summary
Settings - . . . : A
Power analysis from Implemented netlist. Activity On-Chip Power
Summary (3.063 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1.850W
~ Utilization Detail e
fiestion Detaris Total On-Chip Power: 3.063W o% Clocke: 0414w
Hierarchical (1.85 Junction T " 100 °C 0% 2984 ' ) :
unction Temperature: ; - .
Clocks (0114 W) £ Signals:  0.385W
. . |
~ Signals (0,385 W) Thermal Margin: 600 °C (39.4 W) Lagic: 0.089 W
Data ( ' Effective SJA: 1.4 "CIW M BRAN: 1132 W
Clack Enable Power suppliedto off-chip devices: 0W B MhcH: 0125 W
.Sef:fR-eset.E;j vV Confidence level: Medium P o 0.004 W
Logic (0.089 W) Launch Power Constraint Advisor to find and fix
BRAM (1.122 W) invalid switching activity Device Static: 1213 W (40%)

Clock Mananer (1 ~
>

impl_1(saved) X power 1 X

Figure 70: Power Report - Vector Analysis with Junction Temperature Supplied

14. Similarly, you can overwrite the Junction Temperature setting and do a SAIF based power analysis.

Conclusion

In this lab, you have learned to experiment with hardware power measurement using the KCU105
Evaluation Board.

In lab 5, you will learn about using the Power Optimization features in the Vivado IDE.
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Lab 5: Performing Power Optimization

Introduction

In this lab, you will learn about using the Power Optimization features in Vivado® for 7 series devices.
The lab will take you through the steps for invoking Power Optimization after synthesizing the design. It
will also guide you on how to use the power optimization report, make decisions and selectively turn off
power optimization on signals, blocks, and hierarchies.

TIP: When you run Implementation on your design, the Vivado tools may perform BRAM power
optimizations by default during opt_design. These optimizations will not affect performance,
and will have little impact on area and runtime. In the previous Lab, the default BRAM power
optimization was disabled (Step-9 of Lab1) by setting a NoBramPowerOpt directive to
opt_design.

Step 1: Setting Up Options to Run Power Optimization

1. In the Flow Navigator, right click Implementation and select Implementation Settings.
2. In the Project Settings dialog box, select Implementation tab to make the following settings:
¢ In the Opt Design settings, set the —directive option to Default.

BRAM optimization runs in the Default setting for Opt Design during Implementation. BRAM
optimization was disabled in the previous lab. It is now re-enabled when the design runs Power
Optimization.

e In the Power Opt Design settings, check the is_enabled box.

This ensures Power Optimization runs after opt_design. Enabling the Power Opt Design
option prior to place_design results in a complete power optimization to be performed. This
option yields the best possible power saving from the Vivado tools.

Power Analysis and Optimization www.xilinx.com 76
UG997 (v2018.3) December 5, 2018 Send Feedback


http://www.xilinx.com/
https://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG997&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Power%20Analysis%20and%20Optimization&releaseVersion=2018.3&docPage=76

& XILINX

¢ Settings

Project Settings
General
Simulation
Elabaration
Synthesis
Implementation
Bitstream

AP

Tool Settings
Project
IP Defaults
Source File
Display
WebTalk
Help
» Text Editor
3rd Party Simulato
» Colors

Selection Rules

Lab 5: Performing Power Optimization

Implementation
Specify various settings associated to Implementation ‘

Constraints

Default constraint set | &= constrs_1 (active) w

Options

AP LG DIY R UL WS Dy g ey
is_enabled bl

tcl.pre

HIH

tcl post
-verbose
-directive® MoBramPowerOpt 4
More Options
~ Power Opt Design (power_opt_design)
is_enabled bl |

tcl.pre

(]

tcl.post

More Oplions
is_enabled
Optionally run this step as part of the flow. This step optimizes design to maximize power saving.

Ok ‘ | Cancel ‘ | Apply ‘

| Restore. ..

Figure 71: Implementation Settings — Enabling Power Optimization

Shortcuts
Strategies
» Window Behavior ..
{ H
I/:-;.‘I
WS
3. Click OK.
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4. In the Create New Run dialog box, click Yes to “Properties for the completed run ‘impl_1" have been
modified. Do you want to preserve the state of 'impl_1" and apply these changes to a new run?".

Create New Run @

Froperties for the completed run ‘impl_1" have been modified.
Do you want to preserve the state of impl_1" and apply these changes to a new run?

|:| Don't show this dialog again

[=2
m
n
=
(=]

Cancel

Figure 72: Create New Run Dialog Box

5. In the Create Run dialog box, set the Run Name to impl_2.
6. Click OK.

7. In the Flow Navigator, select Run Implementation. Click Don't Save when the Save Project window
pops up to save both Synthesis and Implementation constraints.

[ =

¢ Save Project @

o Save project before launching implementation?

Data to Save
+ | Bynthesized Design - constrs_1 - dut_fpga_kc7 05 xdc

¥ | Implemented Design - constrs_1 - dut_fpga_kc705.xdc

Daont Save cancel

Figure 73: Click “Don’t Save” Here

You are running Implementation with Power Optimization turned on.
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8. In the Implementation Completed dialog box, select Open Implemented Design and click OK. Click
Don't Save when the Save Project window pops up to save both Synthesis and Implementation
constraints.

Lab 5: Performing Power Optimization

Step 2: Running report_power_opt to Examine
User/Design Specific Power Optimizations

1. In the Flow Navigator, select Implemented Design.

2. In the main menu bar, select Reports > Report Power Optimization.

Tools  Window  Layout  View  Help

Floorplanning L o X
QO Planning » 3251fga00-2
Timing b

Edit Timing Constraints

Power Constraints Advisor... 'ﬂ'

*1 Schematic

Show Hierarchy

Report
Edit Device Properties. ..

Create and Package Mew IP..

Create Interface Definition...

Enable Parial Reconfiguration...

Run Tcl Script...

Property Editor

Associate ELF Files...

Generate Memory Configuration File...

Compile Simulation Libraries. .

Xilinx Tcl Store...
Custom Commands
" Language Templates

£+ Settings..

Report Methodology...
Report DRC...

Report Moise. .

Report Utilization...
Repaort Clock Utilization...
Report Power...

Report Power Optimization...
Report High Fanout Mets. .
Report Design Analysis...
Report10...

Report Clock Metworks...
Repaort [P Status

Timing 3

B e e L L LT

Figure 74: Generating a Power Optimization Report
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3. The Report Power Optimization dialog box appears, as shown in the following figure.

- =

¢ Report Power Optimization @

Report power optimization.

Results name: power_opt_1

Export to file:
Cutput file format:

+'| Openin anew tab

f.;ﬂ.\
2 Ok Cancel

Figure 75: Report Power Optimization Dialog Box

4. Enter power_opt_1 for the Results name.

5. Ensure that the Open in a new tab option is checked.

6. Click OK. Alternatively, in the Tcl Console execute this Tcl command:
report_power_opt -name power_opt_1

7. Observe the report power_opt_1 is generated in the Power Opt tab of the results windows area.
When the report opens, the Summary view is displayed in the report.

8. In the Summary view, note that 50% of the BRAMs are clock gated by the tool during Power
Optimization.

Create New Run @

Properties for the completed run ‘impl_1" have been modified.
Cio you want to presene the state of impl_1" and apply these changes to a new run?

[

|:| Daont show this dialog again

Zancel

1=
)

w0

=
=)

Figure 76: Power Optimization Report — Tool Gated BRAMs
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9. In the Power Optimization Report, select Hierarchical Information > BRAMs > Tool Gated
BRAMs and observe the BRAM cells and its CE ports which are gated by the tool during the power
optimization.

Step 3: Running report_power to Examine Power Savings

1. In the main menu bar, select Reports > Report Power.
2. In the Report Power dialog box, make the following settings:
0 Specify the Results name as power_1
0 In the Environment tab, make sure the Process is set to maximum.
3. Click OK. Alternatively, in the Tcl Console execute this Tcl command:
report_power -name power_1

4. In the Summary view of the Power Report, observe an approximately 100-200mW power savings
compared to the non-optimized power run in the previous lab.

You can generate a bitstream to program the hardware and measure its power, to observe the
power saving in hardware. See Lab 3: Measuring Hardware Power Using the KC705 Evaluation for
hardware power measurement instructions.

Power ? - 0&a X
- -~ >
Q x &£ C Summary
Settings - )
g Power analysis from Implemented netlist. Activity On-Chip Power
summary (1.48 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1017 W (59%)
~ Utilization Details
Total On-Chip Power: 148 W acks-
Hierarchical (1.017 _ 23% Clocks: 0.024W
Clocks (0 Junction Temperature: 27.6°C 59% Signals:  0.232W
« Signals | Thermal Margin: 57 4°C(30.2W) Logic: 0.016W
Data (0.232 W Effective SJA: 1.8 "CWw B ERAM: 0624 W
Clock Enable | Power supplied to off-chip devices: 0'W M mch: 0417 W
SetiReset (0 Confidence level: Medium o- 0.004W (0%)
Logic (0.1 ) Launch Power Constraint Advisor to find and fix JEL
BRAM (0.624 ) invalid switching activity Device Static. 0463 W  (31%)
Clock Manager (0.,
| G Ld
power_1

Figure 77: Power Savings with Power Optimization
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Step 4: Turning Off Optimizations on Specific Signals and
Rerunning the Implementation

In this step you will learn how to turn off the power optimization on specific BRAMs.

IMPORTANT: Power optimization works to minimize the impact on timing while maximizing
power savings. However, in certain cases, if timing degrades after power optimization, you can
(dentify and apply power optimizations only on non-timing critical clock domains or modules

using the set_power_opt XDC command.

See the Vivado Design Suite User Guide: Power Analysis and Optimization (UG907) for more
information on the set_power_opt command.

Assume that this BRAM is in the critical path:

dut/gen_dut[0]-bram_top_inst/bram_inst/mem_reg_0_ 0
This step makes sure the tool does not gate this BRAM.

1. In the Tcl Console, type this command:
set_power_opt -exclude_cells [get_cells dut/gen_dut[0].bram_top_inst/bram_inst/mem_reg_0_0]
This will prevent the tool from gating this BRAM.

2. From the Flow Navigator choose Run Implementation, which in turn reruns
power_opt_design.
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3. Click Save in the Save Project dialog box to save the Synthesized Design and Implemented Design
constraints before launching implementation.

-

ga"" Save Project @

[9:, Save project before launching implementation?

Data to Save

| Synthesized Design - synth_1 - constrs_1 - dut_fpga_kc?05. xdc

| Implemented Design - impl_1 - constrs_1 - dut_fpga_kc705, xdc

| Implemented Design -impl_2 - constrs_1 - dut_fpga_kc705. xdc

[ Save || Don't Save || Cancel

Figure 78: Save Design Constraints Before Rerunning Implementation

Also, select Implemented Design - impl_2 in the Save Constraints Conflict dialog box to save the
changes in constraints from the set_power_opt command.

g"‘ Save Constraints Conflict @

! There are unsaved changes to constraints set 'constrs_1' in multiple editors, Please
% choose which changes to save.

Changes to Save
Synthesized Design - synth_1

Implemented Design -impl_1

@) Implemented Design - impl 2

(0]4 ] | Cancel

Figure 79: Saving Design Constraints for impl_2

4. In the Implementation Completed dialog box, select Open Implemented Design and click OK.
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Lab 5: Performing Power Optimization

Step 5: Running report_power_opt to Examine Tool

Optimizations Again

1. In the main menu bar, select Reports > Report Power Optimization.

2. In the Report Power Optimization dialog box, type in the Results name as power_opt_2.

Alternatively, execute this Tcl command in the Tcl Console:

report_power_opt -name power_opt 2

3. In the generated report power_opt_2 in the Power Opt window, display Tool Gated BRAMs.

Power Opt
Qa x = C
General Information
Summary
Recommendations
~ Hierarchical Infarmation
~ BRAMs
User Gated BRAMs
BRAWM WRITE_MODE O
SRLs
*~ Slice Registers
User Gated Slice Regis
Tool Gated Slice Regisi
XPM URAMs

< b3

power_opt_1

Q  Tool Gated BRAMS

Cell Mame

mem_reg_0_0 (RAMB36E1)
mem_reg_0_0 (RAMB36E1)
mem_reg_0_1 (RAMB36E1)
mem_reg_0_1 (RAMB36E1)
mem_reg_0_2 (RAMB36E1)
mem_reg_0_2 (RAMB3G6E1)
mem_reg_0_3 (RAMB36E1)
mem_reg_0_3 (RAMB36E1)
mem_reg_0_4 (RAMB36E1)
mem_reg_0_4 (RAMB36E1)
mem_reg_0_5 (RAMB36E1)
mem_reg_0_5 (RAMB36E1)
mem_reg_0_G& (RAMB36E1)
mem req 0_ 6 (RAMB3GET)

CE Port

ENARDEN
ENBWREN
ENARDEMN
ENBWREN
ENARDEN
ENBWREN
ENARDEN
ENBWREN
ENARDEMN
ENBWREN
ENARDEN
ENBWREN
ENARDEN
ENBWREN

CE Net Mame
dut/gen_dut[0] bram_top_instbram_inst'mem_reg_0_0_EMARDEN_cooolgate_en_sig_2

dut/gen_dut[0]. bram_top_inst/bram_inst'mem_reg_0_0_EMBWREN_cooolgate_en_sig_11

dut/gen_dut{0] bram_top_inst/bram_inst'mem_reg_0_1_EMARDEN_cooolgate_en_sig_3
dut/gen_dut{0].bram_top_instbram_instmem_reg_0_1_ENBWREN_cooolgate_en_sig_12

dut/gen_dut[0].bram_top_instbram_instmem_reg_0_2 ENARDEN_cooolgate_en_sig_4
dut/gen_dut[0].bram_top_instibram_instmem_reg_0_2 ENBWREN_cooolgate_en_sig_13
dut/gen_dut[0].bram_tep_instibram_instmem_reg_0_3_ENARDEN_cooolgate_en_sig_5

dut/gen_dut[0] bram_top_instbram_inst'mem_reg_0_3 EMBWREN_cooolgate_en_sig_14

dut/gen_dut{0] bram_top_inst/bram_inst'mem_reg_0_4_ EMARDEN_cooolgate_en_sig_6

dut/gen_dut{0] bram_top_inst/bram_inst'mem_reg_0_4_EMNBWREN_cooolgate_en_sig_15

dut/gen_dut[0].bram_top_instibram_instmem_reg_0_5_ENARDEN_cooolgate_en_sig_7

dut/gen_dut[0].bram_top_instibram_instmem_reg_0_5 ENBWREN_cooolgate_en_sig_16

dut/gen_dut[0].bram_top_instibram_instmem_reg_0_6 ENARDEN_cooolgate_en_sig 8

dut/oen duti0].bram_top_inst/bram _inst'mem _req_0_ 6 ENBWREN_cooolaate en sig_17

Figure 80: Displaying Tool Gated BRAMs

4. Note that this BRAM is no longer in the list of Tool Gated BRAMs:
dut/gen_dut[0] .bram_top_inst/bram_inst/mem_reg 0 O
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Step 6: Saving Power using UltraScale BRAM in Cascaded
Mode

UltraScale architecture-based devices provide the capability to cascade the data out from one BRAM to
the next BRAM serially. This will enable the devices to create a deeper block RAM in a bottom-up
fashion. When used in cascaded mode, the power consumption is considerably low compared to the
BRAM used in non-cascaded mode.

1.

Run the steps mentioned in Step 1: Creating a New Project shown in Lab 1: Running Power
Analysis in the Vivado Tools.

a. Inthe Add Source Files dialog box, navigate to the
<Extract_Dir>/UltraScale/src for UltraScale devices.

b. In the Add Constraints (optional) dialog box, click Add Files and select
dut_fpga_kcul05.xdc in the file browser. In the directory structure, you will find the
dut_fpga_ kcul05.xdc file below the /src folder.

c. Select the Kintex-UltraScale KCU105 Evaluation Platform (xcku040-ffva156-2-e FPGA),
click Next.

Review the New Project Summary page. Verify that the data appears as expected and click
Finish.

In the Vivado Options dialog box (Tools > Options > General), enter the tutorial project

directory in the Specify project directory box, so that all reports are saved in the tutorial

project directory. Then click OK.

Click Run Synthesis in the Flow Navigator.

The Synthesis Completed dialog box appears after synthesis has completed on the design.

Select Run Implementation in the Synthesis Completed dialog box and click OK.

After the Implementation completes, click Open Implemented Design.

You can see the automatically generated power report impl_1 in the power tab, which shows
as a saved report. This is an autogenerated vectorless power report.

Note the total power (Total On-Chip Power) in the power report Summary page.
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impl_1 (saved)

Power
Q = $ C Summary
Settings . . - "
Power analysis from Implemented netlist. Activity On-Chip Power
Summary (2.343 W) derived from constraints files, simulation files or
Power Supply vectorless analysis. Dynamic: 1.850 W  (79%)
~ Utilization Details
Total On-Chip Power: 2.349 W s Clocks: 0414 W
Hierarchical (1.65 W) Junction T " 283 °C 21% : -
unction Temperature: - ]
Clocks (0.114 W) ) 79% 5% Signals: 0.385W
© Signals (0,285 Thermal Margin T17°C (49.1W) Logie: 0089 W
Data (032 Effective 3JA: 1atcw WBRAM:  1432W
Clock Enable Power supplied to off-chip devices: 0W M vMcH 0425 W
SetReset (0W) Confidence level: Medium 1o 0.004W
Logic (0.0 ) Launch Power Constraint Advisor to find and fix 219
BRAM (1.122 W) invalid switching aciity Device Staic. 0,499 W (21%)
Clock Manager (0125 W,
1O (0.004 W)

?2_-0aX

Figure 81: Power Report Summary

9. Select Hierarchical view in the Utilization Details option on the left panel and observe the

Cascaded and Non-cascaded BRAM power.

Power ? 08X
Q T &£ C QI Hierarchical
Setlings Utilization MName Clocks (W) Signals (W) Data (W) Logic(W) BRAM() Clock Manager (V|
Summary (2.352 W) ~ [ 1.853 W (7 otal) ¥ dut_fpga
Power Supply ~ E—1.719W (73% oftotal) | [@ dut (dul 0.105 0303 0303 0.089 1432 <0.0(
~ Utilization Details > D 1.152'W ) [@ Noncascade_bram (Moncascade_... 0.052 0173 0173 0.051 0.875 =0.0(
> B 0.567 W (249 [@ Cascaded_bram (Cascaded_bram) 0.052 0.22 0.22 0.038 0.257 <0.0(
Clocks (0.11 H0.131 W (6% of total) Leaf Cells (12)
* Signals (0 1% of total) @ in_diff_bufg (IBUFDS) <0.001 <0001  =0.001  <0.001  <0.001 <0.00
Data (0.393 W)
Clock Enable (0 W)
SetReset (0 W)
Logic (0.082 W)
BRAM (1132 W)
Clock Manager (0125 W)
110 (0.004 W)
e — 2 B
impl_2 {saved)
Figure 82: Cascaded and Non Cascaded BRAM Power view
10. You can see 50% to 60% saving in Cascaded BRAM compared to Non Cascaded BRAM.
11. Use the same steps as specified in Step 1, Step 2, and Step 3 to perform SAIF based power
analysis using Vivado Simulator.
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Conclusion

In this tutorial, we have accomplished the following:

Used the Report Power dialog box to verify and set device, thermal, and environmental
conditions that contribute to power estimation.

Synthesized the design and estimated the power after synthesis.
Set switching activities on an I/O port and reran Report Power.

Ran functional simulation using the Vivado simulator and generated a SAIF file that is input to
Report Power for a more accurate power analysis.

Implemented the design, ran post-implementation timing simulation using the Vivado simulator,
and generated a SAIF file that is input to report power for a more accurate power analysis.

Ran Questa Advanced Simulator post-implementation timing simulation and generated a SAIF
file that is input to report power for a more accurate power analysis.

Performed power measurement on the design implemented in a KC705 and KCU105 Evaluation
Boards. Compared the hardware power numbers with the numbers generated by Vivado Report
Power.

Learned how to achieve power optimization as part of an implementation run.

Examined the power optimization report and selectively turned off power optimizations on a cell
in the design.

Examined the power saving of UltraScale BRAMs in cascaded mode when compared to BRAMs
in Non-cascaded mode.
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Legal Notices

Please Read: Important Legal Notices

The information disclosed to you hereunder (the “Materials”) is provided solely for the selection and use of Xilinx products. To the maximum
extent permitted by applicable law: (1) Materials are made available "AS 1S" and with all faults, Xilinx hereby DISCLAIMS ALL WARRANTIES
AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether in contract or tort,
including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related to, arising under, or in
connection with, the Materials (including your use of the Materials), including for any direct, indirect, special, incidental, or consequential loss
or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a result of any action brought by a third party)
even if such damage or loss was reasonably foreseeable or Xilinx had been advised of the possibility of the same. Xilinx assumes no
obligation to correct any errors contained in the Materials or to notify you of updates to the Materials or to product specifications. You may not
reproduce, modify, distribute, or publicly display the Materials without prior written consent. Certain products are subject to the terms and
conditions of Xilinx’s limited warranty, please refer to Xilinx's Terms of Sale which can be viewed at http://www.xilinx.com/legal.htm#tos; IP
cores may be subject to warranty and support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or
intended to be fail-safe or for use in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products
in such critical applications, please refer to Xilinx's Terms of Sale which can be viewed at http://www.xilinx.com/legal.htm#tos.

AUTOMOTIVE APPLICATIONS DISCLAIMER

AUTOMOTIVE PRODUCTS (IDENTIFIED AS “XA” IN THE PART NUMBER) ARE NOT WARRANTED FOR USE IN THE DEPLOYMENT OF
AIRBAGS OR FOR USE IN APPLICATIONS THAT AFFECT CONTROL OF A VEHICLE (“SAFETY APPLICATION") UNLESS THERE IS A
SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD (“SAFETY
DESIGN”). CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS,
THOROUGHLY TEST SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A
SAFETY DESIGN IS FULLY AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING
LIMITATIONS ON PRODUCT LIABILITY.

© Copyright 2012-2018 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Zyng, and other designated brands included herein
are trademarks of Xilinx in the United States and other countries. All other trademarks are the property of their respective owners.
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